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Introduction to DSC Data Analysis 
 

 
MicroCal Origin is a general purpose, scientific and technical data analysis and plotting 
tool.  In addition, Origin can carry add-on routines to solve specific problems.  Analyzing  
Differential Scanning Calorimetric data from the MicroCal MC-2, MCS or VP-DSC 
instruments is one such specific application. 
 
This version of Origin includes routines designed to analyze DSC data.  Most of the DSC 
routines are located in the Peak and DSC (Differential Scanning Calorimeter) menus in 
the Origin menu display bar.  A number of routines are implemented as buttons in plot 
windows.  This tutorial will show you how to use all of the DSC routines.  When 
working through this tutorial it is recommended that you do not save changes to the 
original files, but use a different filename so that the next person may follow this tutorial. 
 
Lesson 1 provides an overview of the entire DSC data analysis and fitting process.  
Please work through this lesson first.  The subsequent lessons each look in more detail at 
particular aspects of DSC data analysis, and may be read in whatever order you see fit. 
 
If you are unfamiliar with the basic operation of Origin, you may find it helpful to read 
through OriginLab's Origin - Getting Started Manual (particularly the introductory 
chapter).  Note that this DSC tutorial contains information about Origin only in so far as 
it applies to DSC data analysis.   
 
If you have questions or comments, we would like to hear from you.  Technical support 
and customer service can be reached at the following numbers: 
 
 
Toll-Free in North America:  800.633.3115 
 
Telephone:  413.586.7720 
 
Fax:  413.586.0149   
 
Email:  info@microcalorimetry.com 
 
Web Page: www.microcalorimetry.com 
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Getting Started 
 

In this chapter we describe how to install Origin on your hard drive, how to configure 
Origin to include the DSC add-on routines, and how to start Origin.   
. 

System Requirements 

Origin version 7 requires the following minimum system configuration: 
• Microsoft Windows® 95 or later or Windows NT® version 4.0 or later. 
• 133 MHz or higher Pentium compatible CPU. 
• 64 megabytes (MB) of RAM 
• CD-ROM drive. 
• 50 MB of free hard disk space. 
• Internet Explorer version 4.0 or later (we recommend version 5.0 or later).  Internet 

Explorer need not be your default browser, but it must be installed for viewing 
Origin's compiled HTML Help. 

Installing Origin - Single User License 

Note: We recommend that when installing Origin you do not accept the default directory, but  
choose the folder  C:\Origin70\ 

 
To install a new copy of Origin or to upgrade an existing copy, insert the Origin 7 CD 
into your CD-ROM.  A window opens with a number of options, including installing 
Origin.  Click the link to install Origin.  If the CD does not start automatically, browse 
the CD and run ORIGINCD.EXE directly. 
 
The Setup program prompts you to type in your Origin serial number and license key.  
These numbers are located inside your registration card in the Origin product package. 
 

 
Please refer to the 'Origin : Getting Started Booklet'  for further information 
 
(When choosing a Destination directory (or folder) name to place Origin, make sure this name or any 
other name in the path does not include a space, otherwise Origin will not operate properly) 
 

 
After installation is complete you will see the Origin70 program folder with the program 
icons.  If you wish to create a shortcut desktop icon you may do the following. Right 
click the MicroCal LLC DSC icon and select copy from the drop down menu, then right 
click anywhere on the desktop and select paste to install a desktop icon for Origin DSC. 
 

Installing Origin for DSC Custom Disk 

After installing Origin you will need to install the Custom disk for the DSC routines (if 
you have purchased other options, the relevant Autosampler, PPC and ITC routines will 
be included on this disk). 

• Insert the Custom Disk CD into your CD-ROM 
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• Using Windows Explorer, navigate to the AddOn Setup sub folder of the Origin 7.0 

folder, and open the Setup.exe application file by double clicking on the filename. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Note: you may also launch the 
setup up program by selecting 
Run from the Start Menus 
then entering 
c:\Origin70\AddOn 
Setup\Setup.exe into the text 
box and clicking OK. 

 

 
 
 
 
 
 

• Follow the instructions on screen. 

 

 

Select the 
AddOn Setup 
Folder 

Double click 
on Setup.exe 
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Registering with OriginLab 

OriginLab™ Corporation., a separate company from MicroCal™ , LLC, produces and 
supports the Origin software package. MicroCal™, LLC produces and supports the 
calorimetric fitting routines imbedded in the Origin for DSC and Origin for ITC 
packages.   MicroCal, LLC will provide technical support for all aspects of the software 
without registration.  OriginLab will not provide technical support for the 
calorimetric fitting routines, but if the copy is registered, will provide standard technical 
support for the general purpose routines of the program . 
Upon receipt of Origin, please fill out and return the registration form included with your 
package to OriginLab.   You may also register at any time by contacting the Customer 
Support Department at OriginLab. 

Starting Origin 

To start Origin, double-click on the Origin 7.0 program icon on the Desk Top.  
Alternatively, click Start, then point to Programs.  Point to the MicroCal Origin70  
folder then click on the MicroCal LLC DSC program icon from the submenu. 

 

Menu Levels 

This DSC version of Origin comes with a minimum of three distinct menu configuration 
options, or menu levels (there are other levels available if you purchased the optional 
PPC software, the Autosampler DSC software or the ITC software).  Each menu level 
has its own distinct menu commands.  After Origin has opened you may change a menus 
level option under the Format:Menu command option. 
 
 
 
The seven menu levels are: 
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General Full Menus - Select this option to run Origin in the generic, non-instrument 
mode.  This menu level contains no instrument-specific routines, but does contain many 
general data analysis and graphics routines that you may find useful for other 
applications. 
 
DSC Data Analysis - Select this option to run Origin in a configuration that includes the 
instrument-specific DSC data analysis routines. 
 
Auto DSC Data Analysis -  Select this option to run Origin in a configuration that 
includes the instrument specific autosampler with DSC data analysis routines for 
handling multiple data files. 
 
PPC Data Analysis - Select this option to run Origin in a configuration that includes the 
instrument-specific PPC data analysis routines.  Note that this menu level is available 
only if you purchased the optional PPC attachment for the DSC. 
 
ITC Data Analysis - Select this option to run Origin in a configuration that includes the 
instrument-specific ITC data analysis routines.  Note that this menu level is available 
only if you purchased the optional ITC software module. 
 
Auto ITC Data Analysis - Select this option to run Origin in a configuration that 
includes the instrument specific autosampler with ITC data analysis routines for handling 
multiple data files..  Note that this menu level is available only if you purchased the 
optional AutoITC software module. 
 
Short Menus - Select this option to run Origin with menus that are an abbreviated 
version of the General Full Menus configuration. 
Note that you cannot switch to a new menu level if there is a maximized plot window or 
worksheet in the current project.  A warning prompt will appear if you try to switch 
levels while a window is maximized.  If this happens, simply click on the window 

Restore button.     You will then be able to switch levels. 

Simultaneously Running DSC and ITC Configurations 

If you purchased the DSC, ITC, Autosampler and PPC software modules, the installation 
program will have automatically created icons in the MicroCal OriginLab program group 
for the relevant software.  This allows you to run the configurations simultaneously.  The 
most likely reason to do this would be if you have the MicroCal DSC with the PPC or 
Autosampler attachment and the MicroCal ITC microcalorimeters, and you intend to run 
them on the same computer. 
 
Double-click on any icon to run that configuration. 
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View Mode 

Each Origin plot window can be viewed in any of four different view modes:  Print View, 
Page View, Window View, and Draft View.  
 
Print View is a true WYSIWYG (What You See is What You Get) view mode.  This 
view mode displays a page that corresponds exactly to the page from your hard copy 
device. Exact font placement and size is guaranteed, at some sacrifice to screen 
appearance, since the printer driver fonts must be scaled to fit their positions on the page 
(this will not harm the appearance of true vector fonts).  This is a slow process, and 
screen refresh speed suffers as a result. Thus, reserve the Print View mode for 
previewing your work prior to printing. 
 
Origin automatically changes to Print View mode when graphics are exported to another 
application and when printing.  The view mode automatically returns to the selected view 
mode after the operation is complete.  
 
Page View provides faster screen updating than Print View , but does not guarantee 
exact text placement on the screen unless you are using typeface scaling software (such 
as Adobe Type Manager).  Use Page View mode until your application is ready for 
printing or copying to another application.  Change to Print View mode to check object 
placement before exporting, copying, or printing. 
 
Window View expands the page to fill up the entire graph window.  Labels, buttons, or 
other objects in a graph window that reside in the gray area of the page are not visible in 
Window View mode. 
 
Draft View has the fastest screen update of the four view modes.  In Draft View, the 
page automatically sizes to fill the graph window.  This is a convenient mode to use 
when you are primarily interested in looking at on-screen data. 
 
Note that view mode will not affect your print-outs.  Only on-screen display is affected. 

 Note About Data Import 

MicroCal offers four versions of the DSC instrument (the MC-2,  the MCS, VP-DSC and 
VP-CAPILLARY DSC).  All together, there are five different data collection software 
packages available for use with these instruments - 1) a DOS-based and 2) a Windows-
based package for the MC-2,  3) a Windows-based package for the MCS 4) a Windows-
based version for the VP-DSC and 5) a Windows based version for the VP-CAPILLARY 
DSC. 
 
This version of Origin, with the optional autosampler module will accept data files from 
any MicroCal DSC instrument, and from any of the five versions of the data collection 
software.  To import a data file generated by the MC-2 DOS-based data collection 
software, you click on the Read Data… button in the RawDSC plot window and select 
MC-2 data (*.dat) from the List Files of type 
box.  To import a data file generated by the 
Windows-based data collection software (either 
from the MC-2,  the MCS or the VP-DSC), you 
click on the Read Data… button in the RawDSC 
plot window and select DSC Data (*.dsc) from 
the List Files of type box.  PLEASE NOTE:  Data 
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file names should not begin with a number, nor should they contain any hyphens, periods 
or spaces. 
 
Once a data file is called into Origin, all further operations on the data are identical, 
regardless of the original source of the data.  Note that, in this tutorial, all data were 
generated by a Windows based data collection software, and so we will be using only the 
DSC data file opening procedure.  If your own data files are generated with DOS data 
collection programs, you must open them via the MC-2 procedure.  Refer to Lesson 1 for 
more information about data import. 
 
An "isothermal" mode of collecting experimental data is available for the VP-DSC.  This 
mode may be used when it is desirable to use the DSC to monitor a process at a constant 
temperature for varying periods of time, such as when determining kinetics of a chemical 
reaction at several different temperatures (e.g., estimates of shelf life).   For this mode 
data is plotted Vs time rather than temperature.  Selecting Isoscan (*.iso) will read in 
data that has been collected in the VP-DSC "isothermal" mode and will plot the data 
(mcal/min) Vs time (seconds). 

Analyzing Previous Versions of Origin (*.ORG) Documents and Projects (*.OPJ) 

To open a previous version of an Origin document (project), select File:Open.  This 
menu command opens the Open dialog box.  Select Old version (*.ORG) from the List 
Files of type: drop-down list.  Select the desired file from the list box and click Open to 
close the dialog box and open the document.  You may then make formatting changes 
and print the graph.  If you wish to analyze the previous version of the document you 
must update the document to version 7.0. 
 
To update a previous version of Origin Document (project), select File:Update to 
Origin 7.0 Interface.  All templates will be updated to new templates compatible with 
version 7.0. You may then analyze the data with version 7.0.  Please note: when you 
update the Origin templates to Origin 7.0 most of the text labeling on the graphs will be 
lost, including the fitting parameters.  If you want to save the old fitting parameters text, 
you must copy the text before you update to Origin 7.0.  To copy the fitting parameter 
text (or any other text) right-click anywhere in the text box and select copy.  After you 
update to Origin 7.0 you may right-click in any of the 7.0 templates and select paste. 
. 

  
 
 
 
 
 
 
 
 
 
 

Shortcut: Saved Origin 
documents or projects 
(*.org or *.opj) may be 
opened from explorer by 
double-clicking on the 
file name. 
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Lesson 1:  Basic DSC Data Analysis 
 
 
This first lesson presents an overview of basic DSC data analysis procedures.  You will 
learn how to start Origin;  read a DSC data file into Origin;  open multiple DSC data 
files;  subtract reference data from sample data;  normalize data by concentration;  create 
and subtract baseline data;  and use Origin's curve fitting models to fit a curve to your 
data.  We will also briefly discuss instrument calibration. 
 
After working through this lesson you will know all of the basic procedures involved in 
analyzing DSC data.  Subsequent chapters look at specific procedural elements in more 
detail. 

Starting Origin 

Before starting this lesson, you should have Origin up and running. If you are in 
Windows: 
 
•  From the Desk Top, double-click on the MicrCal LLC DSC icon.  Or alternatively 

select Start : Programs : OriginLab : MicroCal LLC  DSC. 
 
When you start Origin, the program automatically opens the RawDSC plot window.  
Note that this window contains several buttons.  These buttons let you execute certain 
DSC routines. 

Reading DSC Data 

Before we proceed, you should understand the difference in Origin between a data file 
and a project (or document for versions of Origin previous to 4.0) .  A data file contains 
your experimental data.  In order to plot the data, you must read the data file into an 
Origin project.  A project (or document) will contain both the experimental data and any 
plots you have made from the data. 
 
To save a project, select the File:Save Project or File:SaveProject As command.  The 
project saves as a .OPJ file in Origin 4.0 or higher.  To open a project, use the File:Open 
command. 
 
To import a data file you will use the buttons that are attached to the RawDSC plot 
window.  The RawDSC plot window contains nine buttons, four of which are used for 
data import.  The buttons are described below: 
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BUTTON NAME FUNCTION 
 
Read Data… Reads a data file into the project.  Use this button if the data were 

generated by MicroCal's data collection software. 
 
Subtract Reference After data files have been imported into Origin, use this button  to subtract 

reference data from the sample data. 
 
Normalize Concentration Before you proceed to fit the data, you will need to normalize the result by 

concentration.  Normalizing the data divides by the number of moles of 
the sample substance in the cell, to convert from cal/degree to 
cal/mole/degree.  Concentration normalization is always carried out after 
subtracting the reference data. 

Scan Rate 
Normalization If this option is selected when you open a data file, Origin converts from 

the experimental data units of mcal/minute to units of cal/degree.  You 
should always leave this box checked except when you are checking 
calibration of the instrument.  Click on this checkbox to select or de-select 
this option.  If the box is not checked, then unnormalized raw data will 
read in as mcal/minute 

Delete Time 
Data In  raw data files, separate columns are included for Y axis, temperature , 

and time for each data point. When data are being Scan Rate Normalized, 
the time and temperature data are used to determine scan rate whereupon 
the time data is discarded  and only the normalized Y axis readings and 
temperature data are imported into the project.  The operator has the 
option of importing or not importing the time data ( _time extension) into 
the project as active data, though the time data is not plotted automatically. 

     
Apply Y Offset This is useful for offsetting repetitive scans, so they do not overlap on the 

Y axis.  Click once on the number 0.000 in the offset text box to open the 
offset dialog box. Enter the offset  you wish in the +/-Step Size box  (enter 
the offset in mcal, even though the data are plotted in cal) and click OK.  
Click on either scroll arrow  so the proper positive or negative Y offset for 
the next data set  appears in the offset field.  For each successive data set, 
the offset will advance automatically by the same increment. 

Response Time 
VP-DSC This is used for removing small amounts of peak broadening due to using 

a feed back mode which has a response time too slow to resolve a peak 
adequately.   Refer to pages 88 - 91 for more information. 

Absolute Cp 
VP-DSC This is used to calculate Absolute heat capacity from raw DSC data.  

Refer to pages 54 - 57  for more information.  
 
Binding Constant Clicking this button will open dialog boxes to allow the user to input the 

parameters used to calculate binding constants from DSC data. 
Calculate Delta G(T) Using three experimental parameters of a protein scan, midpoint 

temperature (TM),  enthalpy change at TM (∆H(TM)) and heat capacity 
change at TM (∆CP), the Gibbs free energy (∆G(T) ) may be obtained. at 
temperature (T). 
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The RawDSC window, which contains buttons that are used to import DSC data. 
 
 
 

Two DSC data files (SAMPLE1.DSC and REF1.DSC)  are included for your use with this 
lesson.  SAMPLE1 contains sample DSC data;  REF1 contains the associated reference data.  
Both are located in the [Samples] sub-folder of the [Origin70] folder.  These files were 
obtained on the MC-2 DSC instrument using the Windows data collection software.   Files from 
MCS or VP-DSC data collection software packages are similar, but have different header 
information. 
 
To open the SAMPLE1.DSC sample data file and REF1.DSC reference data file 

 
• Click on the Read Data button in the RawDSC plot window. 

The Import Multiple ASCII  dialog box appears.  
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•  Navigate to the Samples folder from the Look in: drop down list box.  Note: You may 
configure Origin to always look in the Samples  folder (or your own folder) by 
selecting Files:Set Default Folder..  and entering the path in the text box. 

 
•  To add the file Sample1.dsc to the lower list box, double-click on the file Sample1.dsc 

in the "File Name" list box, alternatively you may click on the file and click on the 
Add File(s) button.    Note: When assigning filenames to raw data,  no hyphens/dashes 
or spaces may be used in the filename, the names should not begin with a number nor 
should the letter e be followed by a number. 

 
  •  Repeat the above procedure for the file Ref1.dsc. 
 
  •  Click OK to plot all files in the lower list box into the RAWDSC plot window. 
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You can read any number of data files into the same RawDSC window.  Note that when 
multiple data plots appear in the same window, you can set the active data plot by 
clicking on the plot type icons next to the filename in the legend.  A box around the 
line/symbol type indicates the currently active data plot.  Editing, fitting, and other 
operations can only be carried out on the active plot. 

Subtracting Reference Data 

In most experiments you will have obtained both sample reaction heat data and reference 
data, and will need to subtract the reference data from the sample data. 
 
 

To subtract the REF1 reference data  from the SAMPLE1 sample data 
 
•  Click on the Subtract Reference button in the RawDSC window. 

The Subtract Reference Data dialog box opens.  The first file opened, in this case 
Sample1.DSC, will appear in both the Data and Reference drop down list box.  Note 
that the data set listed in the Reference box will be subtracted from the data set listed 
in the Data box. 

 
•  Select Sample1dsc_cp from the Data drop down list.  Sample1dsc_cp becomes 

highlighted and will be entered as the Data. 
 

•  Select Ref1dsc_cp from the Reference drop down list.  Ref1dsc_cp becomes 
highlighted and will be entered as the Reference. 
 
 
 
 
 
 
 
 
 
 
 
 
 

•  Click OK. 
Every point in Ref1dsc_cp is subtracted from the corresponding point in 
Sample1dsc_cp.  The result is plotted as Sample1dsc_cp in the RawDSC plot 
window. 
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Viewing Worksheet Data 

The series of values from which Origin creates a data plot is called a data set.  Each data 
set is contained in a unique worksheet column.  The data set is named after its worksheet 
and worksheet column, separated by an underscore.  When you opened the 
Sample1.DSC data file, the data were placed in a worksheet named Sample1dsc, with 
the Y data in a column named cp.  Thus the Sample1dsc data set is called 
Sample1dsc_cp. 
 

To open the Sample1dsc worksheet 
 
•  Select Sample1dsc from the data list in the Data menu. 
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The Plot Details dialog box opens.  (Note that you can also open this dialog box by double-
clicking on the data plotted in the RawDSC plot window). 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 

 
•   Click on the Worksheet button. 

The Sample1dsc worksheet opens. 

 
 
 

Normalizing the Data 

Before you proceed to fit (deconvolute) the data, you will need to normalize the result by 
concentration.  Normalizing the data divides by the number of moles of the sample 
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substance in the cell, to convert from cal/degree to cal/mole/degree.  Concentration 
normalization is always carried out after subtracting the reference data. 

To normalize Sample1dsc by concentration 
 
•  Click on the RawDSC window to make it active, or select RawDSC from the Window 

menu. 
 

•   Click on the Normalize Concentration button. 
A dialog box opens. 
 

•  Enter the sample concentration in mM, and the cell volume in ml. 
For this example, enter 0.08 into the Concentration mM text box (Sample1.dsc  was 
at a concentration of 80 µM), and 1.12 in the Cell Vol (ml) text box.  (The 
concentration will automatically appear if you originally entered it into the header of 
the raw data file.  For the VP-DSC, Cell volume is set in the VPViewer.ini 
(CELL1.CON for the MCS, and CALDSC.dat for the MC-2) file in the folder 
containing the data acquisition program and is stored in the header information of each 
data file.) 
 
 
 
 
 
 
 
 
 
 
 

 
 

•   Click OK. 
The Sample1dsc_cp data plot is removed from the RawDSC plot window.  RawDSC 
closes, and a new plot window, NormDATA, opens.  The normalized data are plotted 
as Sample1dsc_cp in the NormDATA plot window. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

To quickly switch 
between Origin 
windows, press and 
hold down the Ctrl key 
while pressing the Tab 
key. 
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Note that NormDATA contains two buttons, which are used in the subtract baseline 
procedure. 

Creating a Baseline 

The final step before deconvolution is to start the baseline session and plot a baseline for 
your data.  You will then decide whether or not to subtract the baseline and, based on that 
decision, choose from one of three curve-fitting models. 
 
 

To start the baseline session 
 
•  Choose the Start Baseline Session command from the Peak menu. 

Based on the normalized data, Origin calculates and plots in red the left and right 
linear line segments from which to determine the baseline.  A new menu bar appears, 
containing the baseline session command menus. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Origin lets you adjust the left and right linear segments, and provides several options for 
connecting the segments to create the baseline.  For this example we will simply accept the 
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default segments as plotted, and connect them using a progress baseline.  For greater detail 
see Lesson 4, Baseline Determinations. 
 

To plot the baseline 
 
· Select Progress Baseline from the Baseline menu. 

Origin calculates and plots the progress baseline. 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 

The progress baseline is created such that each point of the baseline in the peak region 
reflects the extent of progress of the reaction.  For a single transition such as this, the 
area between the progress baseline and the data approximates the total heat change due 
to the transition. 
 

•  Click OK in the menu bar to exit the baseline session. 
Origin asks if you want to subtract the baseline data. 
 

•  Click YES. 
Origin subtracts the baseline data from the normalized data, then exits the baseline 
session. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 



Lesson 1  Basic Data Analysis 

19 

Fitting the Data 

Origin provides four models with which to fit a curve to your data.  All four models use 
the Levenberg/Marquardt (LM) non-linear least-square method.  In general, you will 
want to get the best possible fit using the simplest model that fits the data.  Curve fitting 
is discussed in greater detail in Lesson 5.  This section will serve to acquaint you with the 
basic procedure. 
 
The four curve-fitting models are located in the DSC menu.  They are: 
 
Model Parameters 
 
Model 1:  2 State Tm, H 
Model 2:  Non 2 State Tm, H, Hv 
Model 3:  2 State w/dCp Tm, H, Cp, BL0, BL1 
Model 4:  Dissoc w/dCp Tm, H, Cp, BLO, BL1, n 
 
All models except model 4 offer three menu-selection options (model 4 offers only a 
Cursor Init option): 
 
1)  Cursor Init -allows cursor initialization of each transition (Tm's). 
2)  No Init - accepts the previously defined parameters, if any. 
3)  Simulate.. - allows you to create a transition by entering user-defined parameters. 
 
 
 

 
 
 
We will be using only the Cursor Init options in this lesson. 
 
In the previous section you subtracted a baseline from your normalized data.  Models 1 
and 2 require you to subtract the baseline before fitting, while model 3 requires that you 
NOT subtract the baseline.  Model 1 is the simplest model, so let's try fitting to this 
model first. 
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To fit a curve with the 2-state model (model 1) 

 
•  Select 2-State Cursor Init from the DSC menu. 

Origin integrates the Sample1 data, then opens a dialog box asking you to enter the 
number of transitions. 
 

•  You will fit this data with a single Tm, so enter a 1 and click OK. 
 
 

 
 

•  Double-click to set the Tm for this peak.  Or click once, use the arrow keys to position 
the cursor, then press RETURN.  Set Tm equal to about X = 61. 
 
Origin initializes the fitting parameters, displays the parameters and Chi^2 in the 
Fitting Session dialog box, and draws an initial fit curve. 

 
•  When initialization is complete, the Attention! dialog box appears with the message 

"Done init with fixed Tm's".   
Click OK. 
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The Fitting Session 

You are now in the Advanced Mode of the Fitting Session dialog box.  Note that a new 
window displays the fitting button commands.  Please refer to the Origin User’s Manual 
or press the F1 key for Online help for more information about the fitting procedures. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 

Chi-Sqr Click the Chi-Sqr button to display the reduced chi^2 value for the current 
parameter values. The reduced chi^2 value is displayed in the view box at 
the bottom of the dialog box. This feature allows the user to change the 
values of the parameters (i.e. Tm, ∆H) to see an update of the fit using the 
new parameters.  This option can also be used for a quick simulation of 
curves. 

1 Iter. Click this button to perform one iteration of the Levenberg-Marquardt (LM) 
routine.  At the end of the iteration the fit curve, fitting parameters, and 
Chi^2 are updated. 

100 Iter. Same as above, but performs up to 100 LM iterations.  The number of 
Iterations can be changed in the Advanced Mode fitting sessions window (If 
you are in the Basic Mode, click on the More.. button) and selecting  
Options : Control.  Then change the Max Number of Iterations from the 
drop down list box. 

100 Simplex Iter.  Click this button to perform up to 100  Simplex iterations. Normally, you 
will not need to do this because the Simplex method is much less robust and 
reliable than the LM method. However, if the LM method for a set of data 
behaves poorly, try the Simplex method. 
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Basic...    Click this button to switch from the Advanced Mode of the curve fitting 
dialog box to the Basic Mode which contains its own menu bar, but with 
fewer options for fitting procedures. 

Done! Exits the Fitting Session dialog box, returns to the NormData window, the fit 
curve is plotted and the fitting results are plotted in the Results text window 
and to a text box in the Normdata window. 

•  Use the 1 Iter. & 100 Iter. buttons to control the iteration of the fitting cycles, as  
described above.  Watch the fitting parameters and Chi^2 update in the Fitting 
Session dialog box.  When the Chi^2 value no longer reduces, you may click the Done 
button to exit the session. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
To fit a curve with the non 2-state model (model 2) 

 
• Select Non 2-State Cursor Init from the DSC menu. 

 
•  Repeat the steps you followed above when fitting with the 2-state model.  The fitting 

procedure is identical for the two models. 
 

•  Click Done! when finished.  A fit curve is 
generated, and the fitting results copy to the 
parameter text box in the Normdata 
Window.  Note the difference in parameter 
values between the two models. 
 
 
 
 

To fit a curve with the 2-state w/dCp model (model 3) 
 
Model 3 is designed for use with data having a non-zero ∆Cp.  Model 3 requires that a 
baseline be associated with the data, so first we need to retrieve the baseline we 
subtracted previously.  To do so: 
 
•  Select Simple Math from the Math menu. 

The Math dialog box opens. 
 

Data: Sample1dsc_cp 
Model: MN2State 
Chi^2/DoF = 5.897E4 
Tm 60.79  ±0.022 
∆H 9.180E4 ±503 
∆Hv 9.947E4 ±675 
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•   Select Sample1dsc_cp, then click on the upper => button. 
Sample1dsc_cp copies to the Y1 text box. 
 

•  Select SAMPLE1DSC_CP.BASE (this is the original baseline data set), then click on 
the lower => button. 
SAMPLE1DSC_CP.BASE copies to the Y2 text box. 
 

•  Click in the Operator: text box, and type a "+" in the operator text box. 
 

•  Click OK. 
The original Sample1 data is restored, since the baseline which was subtracted earlier 
has now been added back. 
 

•  Now that you have retrieved the baseline data, go ahead and fit a curve using model 3.  
Select 2 State w/dCp Cursor Init from the DSC menu.  Then follow the same steps 
as outlined for the previous two models.  Click on Done to exit the fitting session. 
 

To format the fitting parameters text 
 
•  Right-click on the text in the plot window and select Properties… form the drop down 

menu. 
The Text Control dialog box opens. 
 

•  Change the text style (for example, change the font to Times New Roman, and point 
size to 16). 
Note that to ensure a true What-You-See-Is-What-You-Get text display on screen, you 
should select the Print View mode from the View menu.  View mode does not affect 
output so, for the sake of screen refresh speed, it is usually adequate to use Page 
View, Window View, or Draft View, all of which are faster. 
 

•  Click OK. 
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Calibration 

We will close this lesson with a brief note about instrument calibration.  Every two or 
three months you will want to calibrate the DSC instrument against the Y axis scale in 
Origin.  To do this you will fill both cells with water, then key in heat pulses to produce a 
calibration file (as described in your DSC instrument manual).  You then open the 
calibration file into Origin, and check that the heat pulses match Origin's Y axis scale 
readings (+/- 1%).  Note that the measured peak heights of 9.008, 6.007, and 3.006 
indicated on the figure below agree very closely with experimentally entered pulses of 9, 
6, and 3 mcal/minute.  Pulse heights can be readily measured using the data reader tool 
from the Toolbox.  One way to do this is to take a reading immediately before the pulse 
and immediately after the pulse, average these two readings, and then subtract the 
average from a third reading taken in the middle of the pulse. 
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When you open a calibration file you must remember not to normalize on scan rate.  
This means you should remove the checkmark from the Scan Rate Normalization 
checkbox in the RawDSC plot window before you read in the data file.  If you neglect to 
do this and leave the scan rate normalization on, your calibration results will be wrong.  
Also note that when unnormalized DSC data are read into Origin, the Y axis units are 
mcal/min rather than cal/deg, which is obtained when data are normalized. 
 
You now know how to perform basic data analysis of DSC files using Origin.  The 
following lessons in this tutorial each look at a specific aspect of DSC data analysis in 
detail.  You may work through these lessons in any order. 
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Lesson 2:  Using the Data Selector Tool 
 

 
The Data Selector is a toolbar tool that is used to select a segment of plotted data.  
Subsequent math, editing, or fitting operations will be carried out on the selected 
segment only. 
 

In this lesson you will learn how to select a plot segment, delete the segment, set the data 
plot display range, and reset the display range.  A sample DSC data file, 
SAMPLE2.DSC, has been included for your use with this lesson. 
 
 

To open the SAMPLE2.DAT data file 
 
•  Select File:New:Project to open a new project. 
 
•  Click on the Read  Data button in the RawDSC window. 

The Import Multiple ASCII dialog box opens. 
 

•  Double-click on Sample2.dsc in the Files list box. 
Sample2.dsc is located in the [Samples] sub-folder of the [Origin70] folder. The file 
name will be added to the lower list box. 
 

•  Click OK. 
 

The Sample2.dsc file opens into the RawDSC plot window.   
 
 

 
 

 
 
 

  
 
 
    Shortcut:  
Click the New Project 
button on the Standard 
toolbar. 

0 20 40 60 80 100 120

-0.001

0.000

0.001

0.002  Sample2dsc_cp

C
p(

ca
l/o C

)

Temperature (oC)

 

 

 



DSC Data Analysis Tutorial Guide 

26 

 
To select a segment of plotted data 

 

•  Click on the Data Selector tool    in the toolbox. 
The Data Selector becomes highlighted. 
The pointer turns into a cross-hair. 
Two data markers appear, one at either end of the Sample2dsc_cp data plot in the 
RawDSC1 plot window. 
 

 
•  Position the cross-hair on the left data marker, hold down the mouse button, and drag 

the marker to the right, approximately to the position shown below.  Or use the arrow 
keys to move the marker:  use the Left or Right arrow keys to select a marker;  use 
Control + Left or Right to move the selected marker (hold down the Control+Shift 
key to increase the speed). 
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•  To set the markers, double-click in the plot window, press Return (pressing the escape 
key with your left index finger is equivalent to pressing Return and this allows you to 
keep your right hand on the mouse), or click on any toolbar tool. 
The markers are set, and the Pointer tool is re-selected (unless you selected a different 
tool). 
 

Any math, editing, or fitting operation now performed will affect only the selected plot 
segment.  For example, you could delete the segment. 
 

To delete the selected plot segment 
 
•  Choose Cut or Clear from the Edit menu, or press the Delete key. 

The selected plot segment is deleted from the plot window.  The selected values are 
also deleted from the SAMPLE2 worksheet. 
The data markers are removed.   You may select Edit:Undo to replace the data. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Data markers are only meant to be displayed temporarily.  They will disappear as soon as 
another data set or plot window becomes active.  To select a segment of data for a longer 
period of time, use the Set Display Range command. 
 
Say that you would like to display or manipulate a central range of data in the 
SAMPLE2 data plot, but you do not want to delete any of the data.  This is an ideal use 
for the Set Display Range command. 
 
 
 

To set data plot display range 
 
•  Click on the Data Selector tool, click on the right data marker, and position it as 

shown below.  Then click on the left data marker, and position it as shown: 
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•  Double-click or press Return to set the markers. 
 

•  Choose Set Display Range from the Data menu. 
The data outside the selected range are hidden from view. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

You may expand your data to fill the graph by selecting Graph: Rescale to Show All. 
All math, editing, and fitting operations will be done on the display range only. 
 
The data outside the display range are not deleted;  they are merely hidden.  Use the 
Reset to Full Range command to bring the hidden data back into view. 

 
 
To reset display to full range 

 
•  Choose Reset to Full Range from the Data menu. 

Origin resets the data markers so as to display the entire curve. 
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Lesson 3:  Integration 
 

If you have created a baseline for a DSC data plot, you can select a range of data to 
integrate.  Integration yields the following information about the data:  integration range, 
temperature range, area, thermal midpoint, and width of curve in degrees C at half 
height.  In this lesson you will use the Data Selector tool to set the integration range, 
integrate the data, copy the integration results to the plot window, and plot the 
integration data. 

Setting Range and Integrating the Data 

As you saw in Lesson 2, all math, editing, and fitting operations are performed on the 
currently selected plot segment or on the current display range.  This is true for 
integration as well.  The first step in integration is to use the Data Selector to set the 
integration range.  If you do not set the integration range, the entire display range will 
be integrated. 
 
Before beginning this lesson, open a new project: 
 
•  Select the File:New:Project (or click on the New Project button) menu item. 

 
•  Click on the Read Data button in the RawDSC1 plot window. 

The Import Multiple ASCII dialog box opens. 
 

•  Double-click on Sample1.dsc (located in the [Samples] sub-folder of the [Origin70] 
folder). 
 

•  Click OK to plot the files from the lower list box. 
SAMPLE1.DSC opens into the RawDSC plot window. 
 

 
Before integrating, you must plot a baseline for the data.  You will then choose to either 
integrate from the baseline, or subtract the baseline and integrate from zero (see Lesson 4 
for more about baseline determinations). 
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Plotting a baseline 

 
•  Select Start Baseline Session from the Peak menu. 

Origin starts the baseline session, and plots two red linear baseline segments. 
 

•  Select Progress Baseline from the Baseline menu. 
Origin connects the linear segments with a progress baseline. 
 

•  Select OK from the menu bar. 
Origin asks if you want to subtract the baseline.  Click No. 
Origin exits the baseline session. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

To set the integration range 
 

•  Click on the Data Selector tool    in the toolbox. 
Two data markers appear on the  SAMPLE1 curve (note that these appear on 
SAMPLE1, and not on the baseline curve, because SAMPLE1 is currently set as the 
active data plot in the Data List, under the Data menu). 
 

•  Using the mouse or the arrow keys, position the data markers approximately as shown 
below. (If you are not sure how to position the markers, refer to Lesson 2 in this 
tutorial.) 
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•  Double-click or press Return to set the markers. 
The area between the markers is the range that will be integrated. 
 
 

To integrate the selected range 
 
•  Since you have created a baseline but have not subtracted it from the data, integrate by 

choosing Integrate from Baseline from the Peak Menu.   
     
    If you had subtracted the baseline from the data, you would integrate by choosing 

Integrate from 0 from the Peak menu. 
 

The area between the two data markers is integrated.  The integration results copy to the  
Script Window. 
Note:  The Script Window may hard to find. It may be located at the bottom edge of the 
work area with just the title bar showing or be hidden.  You may show/hide the Script 
Window by either holding down the Alt key and pressing the number 3 key (not on the 
key pad) or by clicking the Script Window button  located on the standard 
toolbar. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

If you wish, you can reset the markers and try again.  Each time you integrate, the results 
are pasted to the Script Window.  To clear the integration shading from the plot 
window, select Refresh from the Window menu. 
 
The procedure that copies the integration results to the Script Window is a macro called 
EndInteg.  EndInteg is defined in the DSC.CNF file, and can be redefined to customize 
the output to suit your needs.  For more information see the LabTalk Reference 
Manual, available separately from MicroCal. 
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Displaying the Integration Results 

The Script Window is a full-featured text editor.  Use it to edit the integration text, save 
the text to a file, or copy and paste the text with the clipboard. 

To copy the integration results to the plot window 
 
•  Click and drag with the mouse to highlight the integration results in the Script 

Window. 
 

•  Choose Copy from the Script Window Edit menu. 
The text is copied to the clipboard. 

 
• Choose Edit:Paste from the menu bar along the top of the Origin project window. 

The integration text is pasted to the RawDSC1 plot window (the active window). 
 
 

 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
The text as pasted is too large and placed poorly.  Let's reformat and reposition the text, 
and add a text border. 
 
 

To change the text style 
 
•  Right-click on the integration results text in the plot window and select properties 

from the drop down menu. 
The Text Control dialog box opens.  From here you can edit the text, set font style, 
color, and point size, rotate the text, and add a border. 

 

Alernatively, to copy and paste, you 
may right-click on the highlighted 
text, select copy from the menu, then 
right-click where you want to 
position the text label and select 
paste. 
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Note that the Text Control dialog box is divided into two display boxes all text entries 
and formatting is done in the upper text box, the lower text box displays the text as it 
will actually appear (WYSIWYG) in the graph window. 
 

•  Type 12 into the center points text box. 
 

•  Select Black Line from the Background drop down list box. 
Note that if you select none for the Background the box may not be erased till you 
perform a screen refresh (select Window:Refresh). 
 

•  Click OK. 
The Text Control dialog box closes, and the integration results text updates to show 
your changes. 
 

•  Click and drag on the integration results text to place the text in the upper right corner 
of the plot window. 

 
To see the graph exactly as it will appear when printed, switch to the Print View view 
mode.  View mode is chosen from the View menu. 
 
 

To change the view mode 
 
•  Click once on the View menu. 

The View menu commands appear.  Notice that Page View is checkmarked, showing 
it to be the selected view mode.  Page View uses the screen driver to display font 
information. 
 

•  Select Print View from the menu. 
Print View is now the selected view mode.  Print View gets font information directly 
from the printer driver, and is a true WYSIWYG view mode. 
The plot window text is now sized and positioned correctly. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

• Before proceeding with this lesson, re-select the View:Page View command. 
 
For more about view mode see Chapter 12: Plotting: Customizing the Page Display in the 
Origin User’s Manual or select the Index tab from the Help:Origin menu option and 
enter View modes into the upper text box. 
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To remove the data markers 
 
•  Click Data Markers from the Data menu (to remove the check mark). 

Origin hides the data markers. 

Plotting the Integration Area Data 

The integration area data is saved (as a function of X, which is temperature for 
calorimetric data) into a data set named _integ_area.  The leading underscore signifies 
that _integ_area is a temporary data set which will be deleted whenever memory is 
running low.  To access the worksheet of  _integ_area data, or use it for any other 
purpose, you should first copy _integ_area to a permanent data set. 
 
 

To copy the integration area data to a new data set 
 
•  Click on the Edit menu in the Script Window menu bar.  Note that the Script 

Execution command is checkmarked, which means you can currently execute 
LabTalk scripts directly from the Script Window. 
 

•  On a new line, type the following script exactly as it appears.  Be sure to include the 
single space before _integ_area and also before my_test:  Please note that the data 
set name must consist of two parts separated by the underscore character.  The first 
part will be the worksheet name (in this case the worksheet will be named my) the 
second part will be the column name of the data set.  
 
copy _integ_area my_test 
 

•  Press Return. 
Origin should append a semicolon " ; " to the text you just entered.  This indicates that 
the script was executed.  For more information about the Lab-Talk scripting 
language, please refer to the LabTalk manual or select the online 
Help:Programming:LabTalk Reference menu option. 
 
My_test is now an Origin data set that can be plotted and manipulated like any other 
data set. 
 
 

To plot the my_test integration area data 
 

•  Select File:New:Graph 
to open a new plot window. 

                  The Graph1 plot window opens. 
 

• Double-click on the layer icon                  in the Graph1 plot window. 
                               The Layer Control dialog box opens. 

 
•  Click on my_test in the Available Data list, then click on the => button. 
    My_test appears in the Layer Contents list.  All data sets in the Layer Contents list      

will plot in the active layer. 
 

 
 

 
 
  
Shortcut: 
Click on the 
New Graph 
button 
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• Click OK. 
 

The Layer Control dialog box closes, and my_test plots as a line graph in the Graph1 
plot window. 
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Lesson 4:  Baseline Determinations 
 
 
Origin creates a baseline for the reaction heat data by establishing a left linear segment 
and a right linear segment that are considered to be the "baseline region".  Several 
methods can be used to connect these two segments to form the baseline.  In this lesson 
you will learn how to create, format, subtract, and open the related worksheet for a 
baseline.  You will also learn about the various baseline creation options that are 
available. 
 
Baseline commands are located under the Peak menu. 

Starting the Baseline Session 

When you are ready to create a baseline for your data, you must start the baseline 
session.  In this lesson we will create a baseline for the SAMPLE1 DSC data file. 
 
 

To open the SAMPLE1 data file 
 
•  If you are continuing from a previous lesson, first select File:New:Project (or click on 

the New Project icon) to open a new Origin project. 
 
•  Click on the Read Data button in the RawDSC plot window. 

The Import Multiple ASCII dialog box opens. 
 

•  Double-click on Sample1.dsc in the Files list. 
SAMPLE1.DSC is located in the [Samples] sub-folder of the [Origin70] folder.  The 
path and file name will be added to the lower list box. 
 

•  Click OK. 
 

SAMPLE1 opens into the RawDSC plot window. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Shortcut: You can 
program Origin to 
always Look in: the 
Samples folder (or any 
other folder) by 
selecting File:Set 
Default Folder and 
entering a new path in 
the text box 
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Before creating the baseline, you would normally subtract reference data, and then 
normalize the data on concentration.  For the sake of brevity, we will bypass those steps 
here.  They are discussed in detail in Lesson 1, Basic DSC Data Analysis. 
 
 

To start the Baseline Session 
 

• Choose Start Baseline Session from the Peak menu. 
Origin enters the baseline session, and automatically analyzes the data to determine the 
linear segments to be drawn on either side of the peak 

 
 

Note that a new command menu bar now appears at the top of the project.  These 
command menus provide complete control over the baseline determination process, as 
follows: 

 
OK Accepts the current baseline, provides an opportunity to subtract this 

baseline from the data curve, and then exits the baseline session. 
 
Adjust Allows the user to adjust the two linear segments. 
 
Baseline Choose one of five options for creating a baseline, or draw a baseline 

manually. 
 
Cancel Exits the baseline session unconditionally.  The current baseline, if any, is 

deleted. 
 

 
If you are having difficulty seeing the linear segments, you can maximize the plot 
window for a better view. 
 

To maximize the RawDSC plot window 
 

• Click on the Maximize button,                    at the upper-right corner of the window. 
The window zooms to full size. 
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User Adjustment of Linear Segments 

If you are not satisfied with the two automatically determined linear segments, use the 
Adjust menu to change the segments as you see fit.  The Adjust menu provides two 
options:  refit the segments, or move the segments by cursor. 
 
 

To refit the linear segments 
 

• Choose Refit Right Segment from the Adjust menu. 
 
 

 
 
 

•  Click the cross-hair on or near the data you want as the first point of the linear 
segment.  A red cross appears on that point. 
 

•  Use the left and right arrow keys to move the red cross, until you have selected the 
point you want. 
 

•  Press Return.  This sets the selected point as the first point of the linear segment. 
 

•  Repeat the previous three steps to select the last point of the linear segment.  Origin 
now generates a new linear segment by fitting the data between the two points to a 
straight line. 
 

Now for the left linear segment.  Instead of using the refit command, lets adjust the left 
segment by cursor. 
 
 

To move linear segments by cursor 
 
•  Select Move Segments by Cursor from the Adjust menu. 

 
•  Select and move one of the left segment end points by either: 

 
•  Clicking on one of the terminal black squares and dragging the mouse, or 

 
•  Selecting an end point with the LEFT or RIGHT arrow keys, then using the UP and 

DOWN arrow keys to move the point up or down. Use the CONTROL + LEFT or 
CONTROL + RIGHT arrow keys to move the point left or right. 
 

•  Repeat the previous step for the other segment end point. 
 

•  When you are satisfied with the placement of the left linear segment, double-click in 
the plot window, or press the Return key. 
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Choosing a Baseline Option 

Once you have set the linear segments, you are ready to select one of the six options for 
creating a baseline.  You will find the baseline options in the Baseline menu. 
 
 

To select an option for creating the baseline 
 
•  Click on the Baseline menu option. 

 
•  Choose a baseline option from the menu. 

 
•  When you are satisfied with the baseline, click on the OK command in the menu bar to 

exit the baseline session.  Origin gives you the opportunity to subtract the baseline, 
then returns you to the RawDSC window (or, if you had normalized the data, the 
NormDATA plot window). 
 

The six baseline options are described in detail below. 
 
Progress Baseline 
In this option, the baseline in the peak region is created such that each point reflects the 
extent of progress of the reaction.  That is, the placement of a baseline point at any 
temperature in the transition region (i.e., relative to the left and right baseline 
extrapolated to the same temperature) is determined by the fraction of the total area that 
has been completed at that temperature.  The progress baseline for the SAMPLE1 data is 
shown below: 
 



Lesson 4  Baseline Determinations 

41 

 
 
For a single transition such as this, the calculated baseline then approximates the molar 
heat capacity for the mixture of the states as they exist at any temperature in the transition 
region.  The area between this baseline and the data then approximates the total heat 
change due to the transition. 
 
Note that only the slope and intercept of the linear segments are used in the calculation 
for the progress baseline.  The actual end points of the linear segments are not used. 
 
During the calculation of a progress baseline, Origin integrates over the entire display 
range of the active data set.  If you prefer, you can restrict the region of integration to just 
the peak area.  After adjusting the low and high temperature linear baseline segments, use 
the Data Selector tool (described in Lesson 2) to set the region where integration should 
be carried out.  If you now select the Baseline:Progress Baseline command, integration 
will be restricted to the region that lies between the two data markers. 
 
 
Linear Connect 
This baseline is formed by connecting the two linear segments with a straight line, as 
shown below: 
 

 
 

Whereas the progress baseline uses only the linear segment slope and intercept to form 
the baseline, linear connect uses only the position of the two end points. 
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Cubic Connect 
Similar to Linear Connect, except the connection is a cubic polynomial.  The end points 
are used to create the baseline, as with Linear Connect, but with Cubic Connect the slope 
is used also: 
 

 
 

 
Step Baseline 
There are two step baseline options.  Step at Peak is based on a linear connect baseline, 
and places the step directly under the peak.  Step at Half Area places the step at the 
position of half the integrated area: 
 

 
 
 

Move Baseline by Cursor 
This option lets you manually adjust the baseline by specifying the position of each of 
the baseline data points. 
 
To use the Move Baseline by Cursor option, first create a baseline by selecting one of 
the baseline creation commands described above.  Next, select Move Baseline by 
Cursor from the Baseline menu.  Origin places twelve data points along the baseline you 
just created.  To move the data points either click and drag with the mouse, or use the left 
and right arrow keys to select a point, and the up and down arrow keys to move the 
selected point (points can only move vertically). 
 
When you are satisfied with the baseline, double-click or press Return.  A spline 
connection option is automatically applied to the new baseline.  You can remove the 
spline connection by changing the baseline's plot display options (see page 42, below). 
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Cursor Draw Baseline 

Cursor Draw Baseline is another method for creating a baseline.  The Cursor Draw 
Baseline method does not require you to enter the baseline session, set linear segments, 
or select a baseline option.  In this method, you simply draw the baseline directly in the 
plot window. 
 
 

To use the Cursor Draw Baseline option 
 
•  If you have not yet exited the baseline session, do so now by clicking OK or Cancel in 

the baseline session menu bar.   
 

•  Select Cursor Draw Baseline from the Peak menu in the standard menu display bar.  
The cursor changes to a small cross-hair. 
 

•  Double-click with the mouse to place each baseline point.  Each point connects to the 
next with a straight line.  The XY coordinates of the point appear in the Data Display 
Tool.  You can place any number of points you wish. 
 

•  You can also use the arrow keys to place points.  Click once with the mouse to place a 
cross-hair on the screen.  Use the UP, DOWN, LEFT, and RIGHT arrow keys to 
move the cross-hair.  Press RETURN to set the position of a point. 
 

•  When you are satisfied, click on the Pointer tool in the toolbox to set the baseline. 
 

Once you have created a baseline, you can use the Adjust Baseline option to fine-tune 
the default baseline. 
 
 

To adjust the baseline 
 
•  Select Adjust Baseline from the Peak menu. 

The pointer becomes a cross-hair. 
 

•  To adjust a baseline point, click and drag with the mouse.  Or use the arrow keys 
(select a point with LEFT or RIGHT arrows;  move up and down with the UP or 
DOWN arrows;  move left and right with CONTROL + LEFT or CONTROL + 
RIGHT arrows). 
 

•  When you are satisfied, double-click on a data point or press Return to set the 
baseline. 
 

The baseline points in Cursor Draw Baseline and  Move Segments by Cursor connect 
with a straight line by default.  Connect type (and other display options) can be changed 
by double-clicking on a point in the baseline and selecting new options in the Plot 
Details dialog box. 
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To change connect type for a baseline 
 
•  Double-click on the baseline. 

The Plot Details dialog box opens. 
 

•  Select a connection option (e.g., spline, straight, step) from the Connect drop down list 
box. 
 

•  Click OK. 
 

 
Each time you create a baseline, Origin names the baseline data set and appends a 
column to the active dataset worksheet for the baseline data.  The baseline data set is 
given the name NAME.BASE (NAME.DRBASE in the case of Cursor Draw Baseline) 
where NAME is the name of the data set for which you created the baseline.  To see the 
baseline data, open the associated worksheet. 
 
 

To open the worksheet containing baseline data 
 
 • Double-click on the baseline to open the Plot Details dialog box, or select the  baseline 

name from the Data menu, then select Plot from the Format menu to open  the Plot 
Type dialog box. 
 

 •  Click on the Worksheet button. 
 The baseline worksheet opens with the baseline data set named CP.BASE(Y). 
 

 
To subtract the baseline from the  DSC data 

 
•  Select Subtract Baseline from the Peak menu. 

The baseline is subtracted. 

Shortcut to the 
Worksheet:  Right-
click anywhere on the 
data trace and select 
Open Worksheet from 
the drop down menu. 
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 Lesson 5:  Curve Fitting 
 
 

In Lesson 1 we discussed Origin's basic curve fitting procedures.    Here we will look at 
the curve fitting process in greater detail.  In the first section below, we will make some 
general observations about the curve fitting models used in Origin.  Following that, we 
will work through two fitting examples to illustrate some of the flexibility of the curve 
fitting process. 

General Comment 

Origin provides four models with which to fit a curve to your data.  All four models use 
the Levenberg-Marquardt non-linear least-square method, but differ in the number of 
parameters involved, as shown below: 
 
Model     Parameters 
 
Model 1:  2-State with zero DCp  Tm, H 
Model 2:  Non-2-State with zero DCp Tm, H, Hv 
Model 3:  2-State with non-zero DCp Tm, H, Cp, BL0, BL1 
Model 4:  Dissoc with non-zero DCp Tm, H, Cp, BL0, BL1, n 
 
Tm is the thermal midpoint of a transition; H is the calorimetric heat change (∆H); Hv is 
the van't Hoff heat change (∆Hv); Cp is the ∆Cp for each transition;  BL0 and BL1 define 
the slope and intercept of the low-temperature baseline segment; and n is the number of 
sub-units 
 
All of the models except model 4 can be used to fit to one or more transitions.  In the 
case of multiple transitions, each transition has its own complete parameter set; e.g., if 
model 1 is used to fit two overlapping transitions there will be two independent 
parameter sets [Tm1, H1] and [Tm2, H2].  These specify the thermal midpoint (Tm) and the 
heat change (∆H) at the Tm for each transition.  The BL0 and BL1 parameters are an 
exception to this rule.  These parameters appear only once in the model; they are not 
repetitive for each transition. 
 
While all four models use a calorimetric heat change (∆H), only the non-2-state model 
(model 2) has a van't Hoff heat change (∆Hv).  The calorimetric heat H is determined 
only by the area under a transition peak, while the van't Hoff heat Hv is determined only 
by the shape of the transition peak.  The sharper the transition, the larger is Hv, and vice 
versa.  The relationship between H and Hv can sometimes provide insights not accessible 
from H alone, For example, if a protein is composed of two identical domains which 
unfold independently with the same Tm and H, then the ratio of H/Hv will be 2.0, while it 
would be 1.0 if the protein had only a single domain.  If, on the other hand, the protein 
dimerized and the dimer underwent only a single coupled transition then the H/Hv ratio 
would be 0.5.  It is clear from this that the calorimetric heat H refers to heat change per 
mole while Hv is heat change per unfolding unit (called the cooperative unit).  Thus the 
ratio H/Hv can, in simple cases, be thought of as the number of cooperative units per 
mole. 
 
 
(Note:  It is important to realize that the ratio of calorimetric to van't Hoff heat depends 
on concentration normalization, since calorimetric heat is always expressed on a per mole 
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basis.  Thus for the protein dimer example considered above, the ratio will be 0.5 if 
concentration normalization is carried out on a per mole of monomer basis while it will 
be 1.0 if concentration is entered in terms of moles of dimer present.) 
 
      In model 1, it is possible to prescribe that overlapping transitions are either 
independent or sequential in nature.  For example, if two structural domains are 
interacting strongly, it is possible that their transitions will be coupled in a sequential 
manner, whereas the independent model might better describe two transitions which are 
completely uncoupled from one another.  In practice, this choice is often not critical since 
the sequential and independent models lead to virtually identical results whenever the 
Tm's of two transitions are separated by a couple of degrees or more.  To switch 
between, select the DSC:Set Indep/Sequ Model command and answer the prompt that 
appears. 
      Origin provides the option to float all parameters during the fitting procedure, or to 
assign some parameters as fixed and float others.  In fixing a parameter, it may be given 
an invariant numerical value. 
The mathematical derivations for each model are included in the appendix.  In general, 
the objective of most investigators is to use the simplest model (e.g., fewest floating 
parameters) which provides a good fit of the data.  Thus, if data are satisfactorily 
described by the two-state model using two transitions, this is to be preferred over a two-
state model with three transitions or a non-two-state model with two transitions.  It is 
usually only when a given model is unable to fit the data that complexity should be 
increased by adding more fitting parameters. 

Fitting Example 1 

To better understand the flexibility of Origin's curve fitting process, work through the 
following example.  The example uses data from a protein of structure ABA, i.e., two 
identical and non-interacting A domains and a single B domain.  Head-to-head 
covalently-linked dimers can readily form ABA type of structures.  By comparison of 
results from different fitting models, structures of this type can be recognized from DSC 
data. 
 
If you are continuing from the previous lesson, first select File:New:Project (or click on 
the New Project button) to open a new project. 
 
 

Step 1:  Prepare the data 
 
The first step in any fitting procedure is to open the DSC data file and reference data file, 
then prepare the data by subtracting reference data and normalizing the result on 
concentration.  We have dealt with these data preparation procedures in Lesson 1 of this 
tutorial.  Here we will briefly review the steps involved: 
 
1)  Click on the Read Data button in the RawDSC window, and open the 

SAMPLE5.DSC and REF5.DSC data files (located in the [Origin70][Samples] 
folder). 

3) Click on the Subtract Reference button.  The Subtract Reference Data dialog box 
opens. 

4)  Select Sample5dsc_cp for the Data drop down list box entry. 
5)  Select Ref5dsc_cp for the Reference drop down list box entry. 
6)  Click OK to subtract Ref5dsc_cp from Sample5dsc_cp. 
7)  Click on the Concentration Normalization button. 
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8)  Enter 0.074 mM and 1.22 ml in the dialog box, and click OK. 
 
After completing these eight steps, your screen will show the normalized SAMPLE5 
data plotted in the NormDATA plot window. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

It is important to remember that data must always be normalized on concentration before 
doing curve fitting to any of the fitting models. 
 
 

Step 2:  Plot a baseline 
 
As we have discussed elsewhere in this tutorial, the next step is to plot a baseline for the 
data.  Note that the SAMPLE5 plot shows flat baseline segments on either side of the 
transition, with a ∆Cp in between.  The transition itself actually starts and ends at about 
the positions shown by the arrows below: 
 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
To create a good progress baseline for this data, you may wish to manually adjust the 
linear baseline segments so that they are parallel to each other, and coincident with the 
baseline data.  Origin does not use the position of the endpoints of the linear segments to 
calculate the progress baseline, only the slope and offset.  You are thus free to create 
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linear segments of any length, which makes it much easier to align the segments parallel 
to each other. 
To create the baseline: 
1)  Select Peak:Start Baseline Session... 
Origin calculates and draws the two linear baseline segments, faintly visible in the figure 
below: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

2)  Select Adjust:Move Segments by Cursor. 
3)  Beginning with the left linear segment, click and drag on first the left and then the 
right endpoint until the graph looks approximately like the figure below (you can also 
use the arrow keys to move an endpoint.  Use the Up and Down arrows to move up or 
down, Control+Left and Control+Right arrows to move left and right, and Right and 
Left arrows to select a new end point): 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

4)  Now use the cursor to adjust the right linear segment as follows: 
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5)  Select Baseline:Progress Baseline. 
 Origin plots a progress baseline. 
6)  Select OK from the menu bar. 
7)  Click Yes in the dialog box to subtract the progress baseline. 
 
Your graph should now look like this: 

 
 

 
Step 3:  Fit to the least complex model 

 
Generally, you will want to use the simplest model (e.g., with the fewest floating 
parameters) that provides a good fit to the data.  You can then add complexity if 
necessary.  Begin the fitting session by using model 1 (2-state with zero ∆Cp) to fit the 
data.  To do so: 
 
1)  Select 2-State Cursor Init from the DSC menu. 
This starts the fitting session, with model 1 selected.  The Cursor Init option allows you 
to initialize the parameters, rather than accept any existing parameters. 
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2)  Origin prompts you to enter the number of transitions.  The simplest fit would be to 
two transitions, so enter a 2 and click OK. 
3)  Double-click on or near each peak to set a Tm (thermal midpoint) for each transition. 
 
As soon as you set the Tm's, Origin initializes the fitting parameters (in this case Tm1, H1, 
Tm2, H2), displays the parameters in the Fitting Session dialog box, and draws an initial 
fit curve.  An Attention! dialog box notifies you when initialization is complete.  Click 
OK to proceed with the fitting. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
4)  The 1 Iter. and 100 Iter. commands let you control the iteration of the fitting cycles.  
Click on the 100 Iter. button a couple times.  Origin iterates the fitting cycle until the 
change in Chi^2 between two successive iterations is less than a pre-set value (this value 
is determined by the value set in the Tolerance Text box of the Control Parameters dialog 
box, MicroCal has set the default value to be 10-5).  Select 100 Iter. once or twice more.  
At the end of each fitting cycle Origin updates the Chi^2 and fitting parameters values 
and draws a new fit curve.  
By now you should have a pretty good fit to the 70 degree peak, but the fit to the 60 
degree peak is not so satisfying.  At this point you can begin to think about improving the 
fit by adding complexity to the model. 
 
 

Step 4:  Add complexity 
 
You did not get a good fit using model 1 with two 2-state transitions.  While the high 
peak fit pretty well, the low peak did not.  This could mean that the low peak is not really 
a single peak, but two smaller, overlapping peaks that combine and obscure each other.  
To test this hypothesis, see if you can get a better fit using model 1 and three transitions: 
 

1)  Click on the Close button  located in the upper right corner of the Fitting Session 
dialog box to abort the current fit. 
2)  Select 2-State Cursor Init from the DSC menu. 
3)  Type 3 in the "Number of peaks" dialog box, and click OK. 
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4)  Double-click to set each of the three Tm's, one for each transition.  Place the first Tm 
just to the left of the low peak, the second just to the right, and center the third on the 
high peak. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Upon setting the third Tm Origin calculates all three sets of fitting parameters (six 
parameters in all, two for each transition) and displays the initial fit curve. 
 
5)  As before, select 100 Iter. from the menu bar to fit the curve to the data.  After 
several fitting cycles, you should get a pretty good fit, implying that the three-transition 
model describes this data better than the two-transition model. 

 

Fitting Example 2 

 
For multisubunit proteins, it often happens that the subunits dissociate simultaneously 
with the unfolding of the protein, i.e., An  = nA, where n is the number of subunits.  
When this happens, the shape of the DSC peak is broadened relative to unfolding of the 
same protein where no dissociation occurs (e.g., covalently linked subunits).  The 
mathematics for curve fitting to systems which undergo simultaneous unfolding and 
dissociation are included in the Appendix. 
 
You may wish to try fitting the data set in the Origin project Dissoc.OPJ, contained in 
the [Origin70][Samples] folder.   The data was obtained on a helical polypeptide thought 
to contain two identical chains linked together in a coiled-coil state.  These data have 
already been normalized on concentration and a progress baseline has been created, so 
curve fitting may begin immediately.  (Note that whenever using the dissociation model, 
the concentration used for data normalization should be that for the associated low-
temperature state, not that for the dissociated high-temperature state.) 
 
1)  To open Dissoc.OPJ, click Done to exit the fitting session, then select File:Open, 
navigate to the [Samples] sub-folder of the [Origin70] folder, then double-click on the 
file name in the Files list.  Dissoc.OPJ opens to show the lv2p0.cp data set with its 
associated baseline plotted in the NormDATA window: 
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2)  Select fitting model 4, Dissociation w/dCp, Cursor init from the DSC menu. 
 
3)  Step 2 may have caused an error message to appear, warning you that no baseline is 
selected for this data.  If this happened, you need to let Origin know that you want to use 
the baseline supplied with this data, which is named lv2p0_cp.base.  To do this, select the 
Peak : Cursor Pick Baseline command, then double-click on the plotted baseline data.  
When you have finished, again select  Dissociation w/dCp, Cursor init  from the DSC 
menu. 
 
4)  Select 2 as the Number of Subunits. 
 
Note that the number of subunits n and the concentration Ct appear in the  Fitting 
Function  dialog box as non-floating parameters. 
 
 
5) Assign value of  0 to the BL0 and BL1 parameters and remove the checks from each 
Vary? Box so the low temperature baseline is not allowed to float.  Click on 100 Iter a 
couple of times.  You will note that the overall fit curve is fairly good. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 



Lesson 5 Curve Fitting 

53 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
6)  Now, change the value of n from 2.0 to 1.0.  Click on 10 Iter several times.  Note that 
the new fit curve is much worse than the original fit curve (Chi^2 is ca. Five times larger) 
and that the experimental data curve is now substantially broader than the fit curve.  This 
means the data are most consistent with the idea that dissociation into subunits occurs 
simultaneously with unfolding for this polypeptide. 
 
7)  Change the value for n from 1.0 to 4.0 and fit the data again.  It is again obvious that 
the fit is not as good as the original fit using an n value of 2.0, which suggests that the 
polypeptide is morre likely to contain two dissociable subunits rather than four. 
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Fitting Example 3 

The Absolute Cp button will facilitate calculation of Absolute heat capacities for 
proteins (this is discussed in more detail in Appedix IV, starting on page 100.  To 
illustrate the function of this button there are 5 raw data files of chymotrypsinogen 
solutions at five different concentrations covering a 10-fold range from 0.258 to 2.58 
mg/ml.  
 

Step 1: Input the data 
 
The 5 raw data files used for this example are Vcht9bs.dsc, Vcht15bs.dsc, Vcht12bs.dsc, 
Vcht13bs.dsc and Vcht14.dsc.  The concentration of the sample in each scan is .258, 
.516, 1.03, 1.55 and 2.58 mg/ml, respectively.  The samples were run on a VP-DSC at 60 
deg/hr using the passive response mode for each scan.  A buffer-buffer reference trace 
has already been subtracted from each data scan. 
 
1) Click on the Read data button in the RawDSC window, navigate to the 
C:\Origin70\Samples folder and open the Vcht9bs.dsc, Vcht12bs.dsc, Vcht13bs.dsc, 
Vcht14bs.dsc and Vcht15bs.dsc data files. 
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Your Origin graph will look like below. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Notice the square around the line type of the last file opened (in this case data set 
Vcht9bs.dsc) in the legend of the graph.  This indicates it is the active data set.  When 
you click on the Absolute Cp button the routine will convert this data set. 
 
 

Step 2: Converting raw data to absolute heat capacity values. 
 
1)  Click on the Absolute Cp button.   
 
The Absolute Cp dialog box will open with the following default parameters. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
2) For this example all the default parameters are correct1, Click OK.   

                         
1 Literature value for the partial specific volume of chymotrypsinogen is .717 ml/gm, and the coefficient of 
volume expansion is 7x10-4  deg-1. 
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A new window named AbsCp will be created.  With the converted data plotted as shown 
below. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
3) Now hold down the Ctrl key and press the tab key once to switch back to the 

RawDSC window.  
4)  Click on the next data set in the legend to make it the active data set. 
 
 
 
 
 
 
 
 
 
 
5) Click on the Absolute Cp button again. 
 
Repeat steps 1 – 4 for each data set till you have completed the data conversion for all 5 
data sets.   Your graph should now look like below. 
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You may wish to expand the view around 25 deg and add some grid lines. 
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Lesson 6:  Autosampler Data (Optional Accessory) 
 

The Autosampler is an optional accessory for use with the Capillary DSC to allow multiple 
unattended scans.  There are two pharmaceutical applications where multiple scans may be 
required.  The first is optimizing solution conditions for protein formulation stability, where a 
number of solution variables (pH, salts, antibacterial agents, sugars, etc.) are examined to find 
the appropriate blend of additive which maximize protein stability by increasing its melting 
temperature (Tm) (Remmele, R. L., Nightlinger, N. S., Srinivasan, S., & Gombotz, W. R. 
(1998), Pharm. Res. 15, 200-208.).   The second application is determining binding constants 
of protein target molecules to small ligands or other proteins, where Tm shift resulting from 
addition a of a potential drug candidate allows calculation of binding constant to target protein 
(Brandts, J. F. & Lin, L. –N. (1990) Biochemistry 29, 6927-6940.)  The DSC can determine 
the Tms for different drug target complexes at varying concentrations, thereby allowing 
determination of individual binding constants. 

Launching the DSC Autosampler Data Session 

Before starting this lesson, you should have Origin up and running.  The routines for 
Auto DSC files are located in a separate window (named ARawDSC) from the standard 
DSC routines.  In addition to the Auto DSC routines, this window (also known as a menu 
level) contains all the functions of the regular DSC data analysis. 
 

• To launch the Auto DSC menus, double-click on the MicroCal LLC Autosampler icon on 
the Desk Top.  Or alternatively select Start : Programs : OriginLab : MicroCal LLC  
Auto DSC 

 
When you start Origin, the program automatically opens the ARawDSC graph window.  
Note that this window contains several buttons in addition to the regular DSC routines.  
These buttons let you execute certain multiple data file manipulations. 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Auto DSC Buttons 
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The buttons displayed in the gray area to the left of the Origin graph and described below 
are exclusive to the ARawDSC template and allow easy manipulation of the multiple 
Auto DSC files.  Examples of the use of each button are presented in the following 
pages. 
 

Subtract Baseline Allows you to select a baseline to be used to subtract 
from all other scans plotted in the active layer. 

Find One Tm Will determine a single Tm for all scans plotted in the 
active layer 

Find Two Tm Will determine two Tm’s for all scans plotted in the 
active layer 

Find Delta Tm This button will allow you to select a scan to use as a 
reference Tm.  The program will then calculate the 
temperature difference between the reference Tm and  
the Tm’s of all other scans. 

Y Offset When this option is selected you will be prompted to enter a value to 
offset each scan that is plotted in the active layer.  This may be useful 
when scans are overlapping and you want to view individual curves. 

Normalize 
Concentration 

Normalizing the data divides the data by the number of moles of the 
sample substance in the cell, to convert the data from cal/degree to 
cal/mole/degree.  When you click this button all scans will be normalized 
by the concentration (mmoles/l) for each sample. 

Response Time This is used for removing small amounts of peak broadening due to 
using a feedback mode which has a response time too slow to resolve a 
peak adequately.  When you click on this button all scans plotted in the 
active layer will be “corrected” for their response time. The original data 
will be deleted.  For more information about response time, refer to the 
Response Time – VP-DSC section starting on page 88 

Auto Binding Constants This button provides an automated method to calculate ligand-protein  
binding constants for the multiple scans plotted in the active layer. 

Kb Threshold Value When this button is selected you will be prompted to enter a “Threshold 
value” for Kb.  All binding constants that exceed this value will be 
highlighted in the summary table. 

 
 
To input the data 

 
Raw data files from the autosampler are typically a 
series of data files of the form 
FamilyName001.DSC, FamilyName002.DSC, 
FamilyName003.DSC, etc.. The family name may 
have up 9 alphanumerical characters, VPViewerTM 
adds the sequential 3 digit number, therefore there may be a  maximum of 12 characters 
for the filename.  To open the file series click on the Read Data… button and the 
Import Multiple ASCII dialog box will open.  Select the Auto DSC Data (*.dsc) as the 
Files of  type:, the upper File Name list box will list only the first file of the series 
(*001.DSC), but when selected for import all files with the same family name (except for 
rescans, see below) will be read in until the end of the series is reached. 
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Alternatively, you may open individual files or a selection of files similar to the normal 
DSC method.  When you select the Files of type: to be DSC Data (*.dsc), then all files 
with the ‘DSC’ extension will be listed in the upper list box.  You may then manually 
select the files to add to the lower list box and read into Origin. 
 
A third option will allow you to read in all data files with the same family name, 
including rescans. ( Note: Scans that were designated as rescans in VPViewer, when the 
experiment was run, had a sequential alphabet character (i.e. a, b, c, etc.) appended after 
the scan number.) When you select the Files of type: to be Auto Rescans (*.dsc), then 
select the first file of the series (*001.DSC) for file import, all files of the series will be 
read into Origin and plotted. 
 

To open serial Auto DSC (*001.DSC) files 
  
• Click on the Read Data.. button.   

The Import Multiple ASCII dialog box opens.  Select Auto DSC Data (*.dsc) as the Files of 
type:. Only DSC files that have an 001 before the extension dot will be listed. 

 
• Navigate to the C:\Origin70\Samples folder, then select PC20904001.DSC from the files list. 

Please Note: Raw data file names should not begin with a number, nor should they contain any 
hyphens, periods or spaces. 

 
Note:  You may select a default folder for Origin to “Look in” for a data file by selecting  File : Set 
Default Folder… and entering the default path (e.g. for this tutorial you may wish to choose the 
path to be C:\Origin70\Samples 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
• Select the PC20904001.DSC file and click Add File(s). 
 
• Click OK. 

 
The PC20904001 family of files is then read in sequentially (i.e. PC20904001, PC20904002, 
PC20904003, etc.) and plotted in the graph. Use the magnifying glass tool to rescale the graph 
around the peaks.  After rescaling your graph should look similar to what is shown. 
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To Subtract a Baseline  

 
You may select a baseline to subtract from all scans plotted in the active layer by one of three 
methods, Manually Select, File Name or Tray and Well label.  Each method is described 
below. 

 
• Click the Subtract Baseline button. 

 The Select Method dialog box will open. 
   

 
Manually Select 
When you select Manually Select and click OK the 
cursor will change into a cross hair.  You may then 
double click (or single click and press enter) on any 
trace, this trace will then be subtracted from all other 
traces that are plotted in the active layer. 

 
 
 

File Name 
When you select File Name, a text box will pop up 
and you may enter the filename of a file (the file must 
have been read into Origin) to be used to subtract 
from all other traces that are plotted in the active 
layer.  Note: When entering the filename you must 
include the ‘.dsc’ file extension. 
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Tray + Well Label 
When you select Tray + Well Label two text boxes will appear, one will allow you to enter 
the tray number, the second will allow you to enter the well designation.  The sample that was 
in that tray and well will be then used to subtract from all other traces that are plotted in the 
active layer. 
Note: Tray designations must be numbers and not start with zero (0), the Well designation 
was designated when the experiment was set up in VPViewer (and stored in the data file 
header) and may be the number of the well (e.g. 1,2,3, etc.) or the matrix number (e.g. A1, 
A2, etc). 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

• Select Manually Select and click OK.  
The cursor will change to a cross-hair. 

 
• Double click on one of the baselines (i.e PC20904001, PC20904002 or PC20904003).  

The selected baseline will be subtracted from all scans plotted in the active layer, your results 
should look similar to what is shown below.   
Note: There may be a slight Tm shift when using different baselines for subtractions, for this 
example the PC20904003.dsc dataset was selected. 
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To apply the Response Time “correction” 

 
Due to the very fast scan rates available (up 250 deg/hr)  for the Capillary DSC and the finite 
response time of the instrument, there may be some Tm shifting and/or peak broadening.  A 
Response Time button is available that when activated will apply a response time correction for 
all scans plotted in the active layer.  This functions similar to the Response Time button available 
for the standard DSC scans (see pages 88 - 91).  After you apply the time constant the traces will 
change color from black to blue.  The original data will be removed from memory.  
 

• Click the Response Time button.  (Note: make sure to click the Response Time button located 
in the Auto DSC group of buttons and not the button associated with the standard DSC) 
The traces will change in color from black to blue (indicating the Response time “correction” has 
been applied) and the original data has been removed from Origin. 
Note: This action may take a minute or two, if  there are many datasets plotted. 

 
 

 
To Normalize Concentration 

 
When you click the Normalize Concentration button, the data is divided by the number of 
moles of the sample substance in the cell, to convert from cal/degree to cal/mole/degree.  
Concentration normalization is always carried out after subtracting the reference data.   
 
The concentrations (mM) of the proteins are usually entered in VPViewer when setting up the 
experiment and stored in the data file header.  You may verify the concentration values in the 
summary table (Conc. 1) and correct them in the table, if necessary. 
 
• To view the summary table click the Window menu item and select MicroCal VP-DSC 

Autosampler Scans Summary Table from the Windows list. 
The summary table will be displayed, similar to what is shown below (i.e. without the Tm1 
entries), you may edit any of the entries for Conc. 1. 
 

• Select Window:ARawDSC menu item then click the Normalize Concentration button, 
from the Auto DSC group of buttons. 
All data scans will be normalize on the protein concentration (conc. 1), the y axis scale will 
change to kcal/mole/°C and the data will be replotted.  
 
 Note: Normalization on Concentration is applied to all data files, not just the data plotted in 
the active layer.  For baselines and other scans where the value for Concentration 1 may 
have been entered as zero Origin will insert a one (1) for the value to prevent division by 
zero (0). 
 

 
 
 

To Find One Tm 
 

• Click the Find One Tm button 
The program will find one Tm for all scans plotted in the active layer, then display a summary, 
as shown in the table below.  Note: If a scan was not plotted in the active layer (in this case the 
baseline, pc20904003.DSC was subtracted and automatically removed from the active layer) 
then a Tm will not be listed.  The program will try to find a Tm for baselines, if they are plotted 
in the active layer, as can be seen in the first and second scans of the table below. 
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Conc. 1 & Conc. 2 
 
Conc. 1 is the concentration (mM) of the protein in the cell. Conc. 2 is the concentration 
(mM) of the ligand in the cell.  These values are usually entered into the data files when 
setting up the experiments, but may be edited in the table. 
 

• Select the menu item Windows:ARawDSC to return to the ARawDSC window. 

At this point you may wish to save your project for use later in calculating binding constants. 
 
 

 
To Find Delta Tm 

 
You may select a scan to represent as a reference 
Tm, to calculate the shift of Tm’s for all other scans 
that are plotted in the active layer. 
 

• Click the Find Delta Tm button.  
The Select Method dialog box opens. 

 
• Click the File Name option and enter the name 

pc20904004.dsc (this is one of the protein only 
scans) and click Ok.  

 Note: you must enter the .dsc extension. 
The summary table will open listing the filename, Tray #, Well #, Concentration 1, Concentration 
2, the Tm, the Delta Tm and any comments that might have been included in the data file. 
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To apply a Y Offset  
 

Many times when reading in multiple files the curves will overlap each other making it 
difficult to view the individual curves.  You may use the Y Offset button to offset each curve, 
so that at the peak, the closest point of the next curve is offset by the amount entered. 

 
• If you are not continuing from the previous example, read in a series of scans 

(pc20904001.DSC) as described above. 
 

• Click the Y Offset button and the following dialog box will pop up. 
 
 
 
 
 
 
 
 
 
 
 

• You may select the default value or enter a different value and click OK. 
Each curve will be offset so that the closest point of each adjacent curve will be equal to 
the amount entered, as shown below. 
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To Find Two Tm 
 
• Select File:New:Project to open a new Origin project, 

 
• Click on the Read Data.. 

button.   
The Import Multiple ASCII 
dialog box opens, with the Auto 
DSC Data (*.dsc) selected as 
the Files of type.  Only DSC 
files that have an 001 before the 
extension dot will be listed. 
 

• Navigate to the 
C:\Origin70\Samples folder, 
then select AS2Peaks001.DSC 
to add the data file series to the 
lower list box and click OK. 
The AS2Peaks family of data 
files will open and your graph 
should look as shown. 

 
 

To Subtract a Baseline (Tray + Well Label method) 
 

• Click the Subtract Baseline button.   
The Select Method dialog box will open 

 
• Select the Tray + Well Label option and enter the 

number 1 for the tray and A11 for the well matrix 
number. 
The baseline (AS2Peaks006.dsc) will be subtracted from 
all scans that are currently plotted . 

 
 

As described in the previous example, you may select the 
Response Time and Normalize Concentration buttons. 
Note:  The Find Delta Tm does not operate for two Tm’s. 

 
• Click the Find Two Tm button 

The following table will open listing the filename, Tray #, Well #, Concentration 1, 
Concentration 2, Tm1, Tm2 and any comments that might have been included in the data file. 
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Ligand-Protein Binding Constants from Autosampler DSC Data 

Data obtained from DSC scans may be used to calculate binding constants for protein-ligand or protein-
protein interactions ( for further information refer to page 101 of the Appendix).  The addition of a ligand 
into a protein solution acts to shift the transition midpoint to higher temperatures, if that ligand binds to the 
low-temperature native form of the protein.  The more strongly the ligand is bound, the greater the increase 
in Tm.  Accurate estimates of binding constant KB may be obtained from DSC data in the presence and 
absence of ligand.  The parameters required to calculate KB are the protein concentration, ligand 
concentration, the heat ( ∆Ho ) and the heat capacity (∆Cp) change in the absence of ligand, and the 
temperature midpoint of the transition in the presence (Tm ) and absence (To) of Ligand. 
 
The project BindingConstants.OPJ is available in the C:\Origin70\Samples directory for the following 
example to determine binding constants from DSC data.  For the following example we will first determine 
the ∆Cp then ∆H for the protein with no ligand.  The Tm’s for both the bound and unbound protein can be 
read from the previously determined values (refer to the table on page 65). 
 

• Launch a new instance of Origin or select File:New:Project to open a new Origin project. 
 

• Select File:Open navigate to the C:\Origin\Samples directory and select BindingConstants.OPJ 
and click Open. 
Your project should look similar to what is shown below.  This data has had a baseline subtracted, 
has been “corrected” for instrument response time, has been normalized on concentration and the 
Tm’s have been determined. 
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• Select File : New : Graph and click OK. 

A new graph will be created. 
 
 

• Double click on the Layer 1 icon 
located in the upper left  hand 
corner of the new graph. 

 
• Click the pc20904004dsc_cp dataset from the 

Available Data list, to highlight it, then click the right 
pointing arrow, => , to place this dataset in the Layer 
Contents list box and click OK. 
 
 
 

To determine ∆Cp 
• Select the menu item Peak:Start Baseline Session.. 

Origin calculates and plots in red the left and right linear line segments from which to determine 
the baseline.  A new menu bar appears containing the baseline session menus. 
 

• Select the menu item Adjust:Move Segments by Cursor. 
The cursor will change to a cross-hair icon. 
 

• Adjust the low temperature and high temperature segments to approximately what is shown 
below, then double click an endpoint or press enter to set the baseline segments. (See Lesson 4: 
Baseline Determinations for greater detail) 

 
• Select Step at Peak from the Baseline menu. 

The Step at Peak baseline will provide a quick and easy method to determine the ∆Cp.  At this 
point your graph should look similar to what is shown below. 
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• Click OK., then click NO when asked Subtract baseline? 
 

• Select the Data Reader tool from the tools toolbar then use the left and right arrow keys to read the 
difference of baseline y values at the step at the peak, for this example (determined by where the 
baselines were set), there was measured to be a high value of  -2030 and a low value of –3160 at 
the step, to determine the ∆Cp to be approximately 1100 cal/deg/mole.   
Note: Your ∆Cp value will be slightly different depending on where you placed the lower and 
higher temperature baseline segments during the baseline session. 

 
 

To determine ∆H at To by calculating the area under the curve. 

• Select the Data Selector tool and using the mouse or arrow keys position the left data marker to 
the approximate position, as shown below.  This will eliminate any effect of the aberration located 
at the beginning of the scan. 

 
 
 
 
 
 

 
 
 
 
 
  

 
 
 

 
 
 
 
 
 
 
 
 

• To set the markers, press enter or double-click on one of the markers. 
 

• Select Integrate from Baseline from the Peak menu. 
The area of the peak between the markers will be determined and printed in the Script Window.  
For this example the area was found to be equal to approximately 110,000 cal/mole.  Your value 
may be different, depending on where you placed the lower and higher temperature baseline 
segments during the baseline session. 
 
Note: The script window may be hidden near the bottom edge of the workspace,  if the Script 
Window is not open, you may open it by clicking on the Script Window button  
located on the standard tool bar.  
 
 

Data Reader 
Tool 

 

 

Data Selector 
Tool 
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 To calculate a single DSC ligand-protein binding constant from autosampler data 
 

In the following example we will calculate the binding constant for a ligand to a protein then 
extrapolate the binding constant to a different temperature.  From the previous example we 
determined To  (61°C),  ∆Ho  at To (110,000 cal/mole) and ∆Cp (1,100 cal/mole/deg) for the 
protein only.   
For the following example we will use the values from the pc20904006.DSC row of the summary 
table on page 65.  From the table we can see that Tm = 66.57 °C, the Protein Concentration = 
.00009 moles/liter and the Ligand Concentration = .010 moles/liter.  From previous information 
we know the stoichiometry, n=1.  Knowing the heat of binding ∆HB and ∆CP independently,  we 
will extrapolate the KB value to another temperature TF. 
 

• Return to the ARawDSC  window. 
 
• Click the Binding Constant button, from the 

standard DSC group of buttons. 
The Binding Constants from DSC dialog box will pop up. 
 
 
 
 
 
 
 
 
 
 
 
 
 

•  Select the Ligand-protein 
interactions radio button and click OK. 

 
The Ligand-Protein Interaction dialog box will open up. 

 
 
• Enter the following values in to the Ligand-

Protein Interaction dialog box, as determined in 
the preceding pages. 

 
 
To = 61 °C 
Tm = 66.57 °C 
n = 1 
∆Ho at To = 110000 cal/mole 
∆Cp = 1100 cal/mole/deg 
Protein Conc. = .00009 moles/l 
Ligand Conc. = .01 moles/l 
 
 
 
 

• Click OK 
 

The binding constant at Tm will be calculated and 
the Binding Results dialog box will open listing 
the entered parameters and the calculated KB.   
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You may print the results and/or extrapolate the KB to a different temperature.   
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To extrapolate the binding constant to a different temperature. 
 

When extrapolating the binding constant to a different temperature you must determine ∆HB and  
∆CpB from an ITC experiment or other independent information. 

 
• Click the Calculate KB at a different temperature TF check box to insert a checkmark, then click 

OK.  
 

• Enter the following values in the parameter text boxes. 
 

Tf = 25 °C 
∆HB at TF = -15000 cal/mole 
∆CpB = -1000 cal/mole/deg 
 

• Click OK. 
 

 
 
 
 
 
 
 
 
 
 
The binding constant at TF will be calculated and the following dialog box will open listing the 
entered parameters and the extrapolated KB.  You may print the results or click OK or Close to 
close the dialog box.  
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Ligand-Protein Binding Constants from Multiple Samples 

• Launch an new instance of Origin. 
 

• Select File:Open navigate to the C:\Origin\Samples directory, select the project  
BindingConstants.OPJ and click Open. 

 
Your project should look similar to what is shown below.  This data has had a baseline subtracted, 
has been “corrected” for instrument response time, has been normalized on concentration and the 
Tm has been determined. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

• Click the Auto Binding Constants button from the Auto DSC button group. 

The DSC Ligand-Protein Binding Constants dialog box will open 
 
 

• Enter the following values, as determined in the 
preceding pages. 

 
 

To = 61 °C 
n = 1.0 
∆Ho at To = 110000 cal/mole 
∆Cp = 1100 cal/mole/deg 

 
 
 

• Click OK. 
The binding constants are calculated for all data 
sets that are plotted in the active layer and listed 
in the summary table. 
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To find KB values that exceed a  “KB Threshold Value” 
 

You may easily find binding constants that exceed a designated value by entering a “threshold 
value” for  KB.  All values in the summary table that exceed the designated value will be 
highlighted. 

 
• Return to the ARawDSC window by selecting Window : ARawDSC. 

• Click the Kb Threshold Value button located in the Auto DSC button group. 

The following dialog box opens. 
 
 
 
 
 
 
 
 

• Enter a threshold value (e.g. 1500) and 
click OK. 
The Summary Table will become the active window and cells in the table of  all KB values that 
exceed the entered value will be highlighted. 
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Lesson 7:  Other Useful Details 

Ligand-Protein Binding Constants from Standard DSC Data 

Data obtained from standard DSC scans may be used to calculate binding constants for protein-
ligand or protein-protein interactions (as discussed on page 101 of the Appendix).  The addition of 
a ligand into a protein solution acts to shift the transition midpoint to higher temperatures, if that 
ligand binds to the low-temperature native form of the protein.  The more strongly the ligand is 
bound, the greater the increase in Tm.  Accurate estimates of binding constant KB may be obtained 
from DSC data in the presence and absence of ligand.  The parameters required to calculate KB are 
the protein concentration, ligand concentration, the heat ( ∆Ho ) and the heat capacity (∆Cp) 
change in the absence of ligand, and the temperature midpoint of the transition in the presence  
(Tm ) and absence (To) of Ligand. 
 
The equations and parameters required to calculate binding constants for the standard DSC are the 
same as used with autosampler DSC data.  The methods used are a little different;   (∆Cp  and ∆Ho  
are determined by the same method (see below and pages  69 - 70) for both autosampler and 
standard DSC data.  The peak temperatures (To and Tm) are determined automatically by 
autosampler routines, but require some user interaction (see page 80) for standard DSC data.   

 
• Launch a new instance of Origin or select File:New:Project to open a new Origin project, 

 
• Select File:Open navigate to the C:\Origin70\Samples directory and select Binding Data from 

standard DSC.OPJ and click Open. 
This project contains 3 data files, one with the protein in the absence of ligand, one with  the 
protein in the presence of ligand 1, and another with the protein in the presence of ligand2 .  The 
data has had a baseline subtracted , “corrected” for the response time of the instrument and has 
been normalized on concentration.   
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• Select File : New : Graph and click OK. 
A new graph will become the active graph in Origin. 
 

• Double click on the Layer 1 icon located in the upper left  hand corner of the new graph. 
 

• Click the bindproteinon_cp’ 
dataset from the Available Data list, 
to highlight it, then click the right 
pointing arrow, => , to place this 
dataset in the Layer Contents list 
box and click OK. 
Note: The apostrophe ‘ at the end of 
the data set name indicates that this 
data has been “corrected” for the 
response time of the instrument. 
 
 

To determine ∆Cp 
• Select the menu item Peak : Start Baseline Session.. 

Origin calculates and plots in red the left and right linear line segments from which to determine 
the baseline.  A new menu bar appears containing the baseline session menus. 
 

• Select the menu item Adjust : Move Segments by Cursor, adjust the low temperature and high 
temperature segments, then double click an endpoint or press enter to set the baseline segments. 
(See Lesson 4: Baseline Determinations for greater detail) 

 
• Select Step at Peak from the Baseline menu. 

The Step at Peak baseline will provide a quick and easy method to determine the ∆Cp.  At this 
point your graph should look similar to what is shown below. 
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• Click OK., then click NO when asked Subtract baseline? 

 
• Select the Data Reader tool, then use the left and right arrow keys to read the difference of 

baseline y values at the step of the peak, for this example (determined by where the baselines were 
set), there was measured to be a high value of  -1960 and a low value of –3040 at the step, for a 
∆Cp to be approximately 1100 cal/deg/mole.   
Note: Your ∆Cp value may be different, depending on where you placed the lower and higher 
temperature baseline segments during the baseline session. 

 
 

To determine ∆H by calculating the area under the curve. 

• Select the Data Selector tool and using the mouse or arrow keys position the left data marker to 
the approximate position, as shown below.  This will eliminate the effect of the aberration located 
at the beginning of the scan. 

 
 
 
 
 
 
 

 
 
 
 
 
  

 
 
 

 
 
 
 
 
 
 
 
 
 

• To set the markers, press enter or double-click on one of the markers. 
 

• Select the Peak : Integrate from Baseline menu item. 
The area of the peak between the markers will be determined and listed in the Script Window.  
For this example the area was found to be equal to approximately 110,000 cal/mole.  Your value 
may be different depending on where you placed the lower and higher temperature baseline 
segments during the baseline session. 
Note: The script window may be hidden near the bottom edge of the workspace,  if the Script 
Window is not open, you may open it by clicking on the Script Window button                          
located on the standard tool bar.  

Data Reader 
Tool 

Data Selector 
Tool 
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To find the peak temperature 
 
• Return to the NormDATA window (select Window : NormDATA). 

 
• Select the Tools : Pick Peaks menu item. 

The Pick Peaks dialog box will open.  Enter the options that are shown.  
 
 The Pick Peaks tool operates on the active data plot in the graph 
window.  (Refer to Origin’s on-line help for more information about the 
Pick Peaks tool.) 

 
• Make the bindproteinon_cp’ data set the active data set by selecting 

Data and clicking on the BINDPROTEINON: temp(x), cp’(y) menu 
item to place a check mark next to the name.   

 
• Click the Find Peaks button on the Pick Peaks dialog box.  Origin will 

place a cross at the peak and print the temperature.  
The peak temperature (T0) should be ca.  61.0°C for the protein only 

scan. 
 

•  Make the data set bindligand1d_cp’ the active data set, then click the 
Find Peaks button. 
The peak temperature should be ca. 66.6°C for the protein with ligand 1 
 

•  Close the Pick Peaks dialog box. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Shortcut:  You 
may make a data 
set, the active data 
set, by clicking on 
the plot type icon 
in the legend. 
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 To calculate the ligand-protein binding constant 
 

• Return to the RawDSC window (i.e. select the 
menu item Window:RawDSC) 

 
• Click the Binding Constant button and the 

Binding Constants from DSC dialog box will 
open up. 

 
• Click the Ligand-protein interactions radio 

button then click OK. 
The Ligand-protein interactions dialog box will 
open up, as shown below. 

 
• Enter the following values, as determined in the 

preceding pages (pages 78 - 80). 
 

To = 61 °C 
Tm = 66.6 °C 
n = 1 
∆Ho at To = 110000 cal/mole 
∆Cp = 1100 cal/mole/deg 
Protein Conc. = .00009 moles/l 
Ligand Conc. = .010 moles/l 

 
 
 
 

• Click OK 
The binding constant at Tm will be calculated and 
the Binding Results dialog box will open listing the 
entered parameters and the calculated KB.  You may 
print the results and/or calculate the KB at a different temperature. 
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To extrapolate the binding constant to a different temperature. 
 

• Click the Calculate KB at a different 
temperature Tf  check box to insert a 
checkmark, then click OK. A new dialog box 
will open up allowing you to enter the 
parameter information to extrapolate the KB 
value to another temperature.  Choose the File 
pc20904007.DSC to use for extrapolating the  
binding constant to a different temperature. 
Repeat the method described on the previous 
pages to determine the ∆H and the ∆Cp at the 
different temperature Tf .  

 
 

• Enter the following values in the parameter text boxes. 
 

Tf = 25 °C 
HB at Tf = -15000 cal/mole/deg 
∆CpB = -1000 cal/mole 
 

• Click OK. 
 

 
The binding constant at Tf will be calculated and the following dialog box will open listing the 
entered parameters and the extrapolated KB.  You may print the results. 
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Protein-Protein Binding Constants from Standard DSC Data 

When estimating the binding constant for protein-protein interactions, the approach is a little different 
than for ligand-protein interactions, since both of the proteins P and P’ will undergo their own thermal 
unfolding transition with transition temperatures To and To’.  When P and P’ are mixed together in the 
same solution, then a separate transition will be observed for the complex PP’ with transition midpoint 
TM.  If TM occurs at a temperature between To and To’ then the regular model for ligand-protein is used 
to calculate the binding constant. 
If TM occurs at a temperature higher than both To and To’ then a different model is used which takes 
into account the temperature shift in both transitions.  Please refer to the Section VI of the Appendix 
for more information about protein-protein binding constants. 
 
The procedure for measuring binding constants of protein-protein interactions is similar to that of 
ligand-protein interactions, as described in the previous pages.  Separate DSC experiments of each 
protein alone must be performed to determine the respective values of  To, ∆Ho , and ∆Cp and 
experiments on the complex of the two proteins are performed to measure the TM values.    

Protein-Protein Binding Constants from Standard DSC Data –  To  < TM  < To’ 

• Launch a new instance of  Origin for DSC 
 

Note: Normally, you would calculate the parameters ∆Cp, ∆Ho, To for each protein and the TM 
for the complex. Since the method of these calculations has been described on pages  78 - 80, we 
will simply provide the parameters below. 

 
• Click the Binding Constant button and the 

Binding Constants from DSC dialog box will 
open up. 

 
• Click the Protein-protein interactions 

(To<Tm< To’ ) radio button then click OK. 
The Protein-protein interactions dialog box will 
open up, as shown below. 
 

• Enter the following values: 
 
 
 

To = 50 °C 
TM = 58.3 °C 
∆Ho at To = 150000 cal/mole 
∆Cp at To = 2000 cal/mole/deg 
Protein Conc. (P) = .00004 moles/l 
Protein Conc. (P’) = .00004 moles/l 
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• Click OK. 

The binding constant at Tm will be calculated and the Binding Results dialog box will 
open listing the entered parameters and the calculated KB.  You may print the results 
and/or calculate the KB at a different temperature 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Protein-Protein Binding Constants – TM >To , To’ 

 If TM occurs at a temperature higher than both To and To’ then a different model is used which 
takes into account the temperature shift in both transitions. 

 
 
To calculate the binding constant at TM , KB(TM), when TM > To, To’ 

 
• Launch a new instance of  Origin for DSC 

 
Note: Normally, you would calculate the parameters ∆Cp, ∆Ho, To for each protein and the TM 
for the complex. Since the method of these calculations has been described on pages  78 - 80, we 
will simply provide the parameters below. 

 
• Click the Binding Constant button and the DSC 

Binding Constants from DSC dialog box will open 
up. 

 
 
 
 
 
 
 
• Click the Protein-protein interactions (Tm>To, To’ ) radio button then click OK. 

The Protein-protein interactions dialog box will open up, as shown below. 
 

• Enter the following values. 
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To = 50 °C 
∆Ho at To = 150000 cal/mole 
∆Cp at To = 2000 cal/mole/deg 
Protein Conc. (P) = .0001 moles/l 
To’ = 65 °C 
∆Ho at To’ = 150000 cal/mole 
∆Cp at To’ = 2000 cal/mole/deg 
Protein Conc. (P’) = .0001 moles/l 
TM = 68.4 °C 
 
 
 

 
 
 
 
 
 
 

 
 
• Click OK. 

The binding constant at Tm will be calculated and the Binding Results dialog box will open 
listing the entered parameters and the calculated KB.  You may print the results and/or 
calculate the KB at a different temperature 
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To extrapolate the binding constant to a different temperature. 
 

When extrapolating the binding constant to a different temperature you must determine ∆HB and  
∆CpB from an ITC experiment or other independent information. 

 
• Click the Calculate KB at a different temperature Tf  check box to insert a checkmark, then click 

OK. A new dialog box will open up allowing you to enter the parameter information to 
extrapolate the KB value to another temperature.    

 
 

• Enter the following values in the parameter text 
boxes. 

 
Tf = 25 °C 
HB at Tf = -15000 cal/mole 
∆CpB = -1000 cal/mole/deg 
 
 
 
 
 
 

• Click OK. 
 

The binding constant at Tf will be calculated and the following dialog box will open listing the 
entered parameters and the extrapolated KB.  You may print the results. 
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Calculate ∆G at temperature T 

From analysis of a DSC scan on a protein, three experimental parameters for the 
unfolding transition are obtained.  These include midpoint = TM ,Enthalpy change at TM = 
∆H(TM) and Heat capacity change at TM = ∆Cp 
 
Using these three experimental parameters, the Gibbs free energy change ∆G may then 
be obtained at any temperature T.  The routine assumes a reversible two-state transition 
and also assumes ∆Cp is independent of temperature. 
 

To calculate ∆G at temperature T 

• Click the Calculate Delta G(T) button. 
The calculate Delta G(T) dialog box opens. 
 

• Enter the following values for TM, ∆H(TM) and 
∆Cp,. 
 
TM  =  60 °C 
∆H(TM) =  110000 cal/mole 
∆CP =  2500 cal/mole/deg 
 

• Click OK. 
A new window opens plotting ∆G from 0 to 90 °C, at 1degree intervals.  A dashed line is 
plotted at y=0 and crosses the ∆G curve at the temperature, TM . 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

• You may use the Data Reader tool to read the value of ∆G at any integer temperature 
from 0 to 90 °C.  For example at 25 °C, ∆G is ca. 6840.  

0 20 40 60 80 100
-15000

-10000

-5000

0

5000

10000

∆
G

Temperature °C

 DeltaG

Use the Data Reader tool 
to read the value of ∆G 
at any integer 
temperature from 0 to  
90 °C
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Chi-square (chi^2) Minimization 

The aim of the fitting procedure is to find those values of the parameters which best 
describe the data.  The standard way of defining the best fit is to choose the parameters 
so that the sum of the squares of the deviations of the theoretical curve(s) from the 
experimental points for a range of independent variables is at a minimum.  For the ITC 
models, where there is no weighting, the theoretical models can be represented by: 
 
       
 
    
where: 
 pi = the fitting parameters 
      
the expression for χ2 simplifies to : 
 

 
 
where: 
 
 neff = the total number of experimental points used in the fitting 
 
 p = total number of adjustable parameters 
 
 yi = experimental data points 
  
 f(x;p1,p2,p3,…) = fitting function 
 
Note: the difference d = neff - p is usually referred to as the number of degrees of freedom. 
 
The above equation states that the Chi squared value of the fit is equal to the sum of the 
squares of the deviations of the theoretical curve(s) from the experimental points divided 
by the number of degrees of freedom.  Since there is no weighting, it can be seen that the 
calculated values are dependent on the magnitude of the scale and the number of data 
points.  After fitting this value is reported as Chi^2/DoF.   

Response Time – VP-DSC 

The VP-DSC is the first calorimeter to have operator-selectable response time.  It is made 
possible by passage of the amplified ∆T signal (temperature difference signal between 
the two cells) into the computer for digital processing before the feedback voltage is 
returned to provide feedback power to the sample cell.  This allows software control of 
the gain (the ratio of power applied to the sample cell relative to the magnitude of the  ∆T 
signal) which in turn controls the response time of the instrument to heat effects 
occurring in the cells.  The passive mode with zero gain is best to use for studying 
systems having very slow transients (broad transition peaks, slow scan rates, or 
isothermal studies) since the baseline is quieter and more stable due to the absence of 
feedback noise.   For systems with fast transients (sharp thermal transitions and/or fast 
scan rates), shorter response times must be used to avoid distorting the shape of the 
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thermogram even though this will result in lower sensitivity.   In the current version of 
VPViewer, there are four response time selections in the experiment set-up window No-
Gain (Passive), Low-Gain, Mid-Gain and High-Gain, with respective relaxation time 
constants of 40.9, 18.0, 10.4 and 5.6 seconds.  The respective designations in the header 
of the data files are 0 (Passive), .5 (Low-Gain), .75 (Mid-Gain) and 1 (High-Gain). 
 
Some protein transitions, as well as those of polynucleotides, are fairly sharp on the 
temperature axis so that detectable peak broadening may result when using the passive 
mode at usual scan rates.  In such a case, faster response times or slower scan rates may 
be used to improve peak resolution in real time.  However, Origin contains a Response 
Time button, which when activated quickly removes small amounts of response-time 
broadening for any of the four response times.  This post-run capability sometimes 
avoids the necessity of introducing extraneous noise associated with faster response 
times, as well as allowing the operator to quickly determine if peak resolution is 
satisfactory for any data set.  Whenever peak broadening is severe, however, this post-
run correction will not be completely accurate. 
 
To illustrate the functionality of the Response Time button we have included the Origin 
project ResponseT.opj in the C:\Origin70\Samples directory.  This Origin project 
contains the results of two successive experiments run on a sample at 60 deg/hr.  The 
first experiment was scanned using the Passive FeedBack mode, the scan was repeated 
using the High-Gain Mode.  The data was scanrate normalized and a baseline has been 
subtracted from each trace.   
 
•  Select  File:Open. 

 
•  Navigate to the [Origin70][Samples] directory , double –click the project name 

ResponseT.opj.  The project will open as shown below. 
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You may see from the that the data collected in the passive mode (dashed line) has a 
slightly higher Tm and is slightly broadened from the data collected at the High-Gain 
FeedBack mode (fastest response time). 
 

•  Make sure the data set Vcht20b2ds_cp is the active data 
set (box in legend is around the dashed line type of the 
Vcht20b2ds_cp data set). 
 
 

•  Click on the Response Time button.  The Response Time dialog box will open. 
 

•  Enter 0 for the FeedBack Mode (No Gain) and 
40.9 for the Relaxation Response Time.  The 
scanrate will be automatically entered.   
Please Note:  Normally the FeedBack Mode 
and Relaxation Response Time will be read 
in from your experimental data file. 

 
 

•  Click OK.  A new curve will be generated and plotted as a blue line (shown below as a 
wider line).  This is the modified curve, for the passive mode, that removed the small 
amount of response-time broadening.  The smaller peak of the repeated scan (using 
High-Gain FeedBack) is due to some non-reversibility of the sample. 
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Line Types for Fit Curves 

You may select a line type to plot your data or fit curves from the Plot Details dialog 
box.  The Plot Details dialog box is available by double-clicking on the data plot, right-
clicking on the data plot and selecting Plot Details from the shortcut menu or selecting 
the desired data plot from the Data menu data list and selecting Format:Plot.  
 

The Line Group 
 
Select the desired line connection from the associated drop-down list.  The line 
connection type affects interpolation results.  The default line type for fit curves is 
Straight line.  The most common methods of connecting the fit curve data points are 
straight, spline or B-spline: 
 
Straight:  A straight line is displayed between data points.  This type of line 
connection will not give a smooth representation of the fit curve if there are few data 
points. 
 
Spline:  This option generates a cubic spline connection. To use the connection, the X 
values must be discrete and increasing. Furthermore, the number of data points cannot 
exceed 900 (if the data set exceeds this number, the operation will fail).  
Since curvature information is held in memory, the spline resolution remains the same 
regardless of page magnification. The SplineStep variable in the ORIGIN.INI file 
controls the spline calculation increment. It is expressed in units of .1 point.  This is 
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usually the most satisfactory representation of the fit curve, but may exhibit an excursion 
from the actual fit curve if there is a sharp corner in the dataa. 
 
B-Spline: The B-spline curve can be described by parametric equations.  Unlike spline 
curves, which pass through the original data points, the B-spline curve winds around the 
original data points without passing through them.  Thus this curve may not produce a 
satisfactory representation of the fit curve.  For a complete discussion of the B-spline 
connection, see the Origin User's Manual.   
 

Inserting an Origin graph into Microsoft® Word 

There are two ways to include your Origin graph into Word (or other applications), you 
may import your graph into Word or you may share your graph with Word.  When you 
import your graph, Word will display the graph as an object and it cannot be edited by 
Origin tools (although it may be resized or reposition in the Word document).  When you 
share your graph, Word displays the graph as an object which can be edited by Origin, or 
linked to Origin and updated when the Origin graph changes. 
Please refer to the Origin manual for more information about Creating a Graphic 
Presentation. 
 
 
 
 

Importing your graph into Word  
 

• Create your graph in Origin and when you are satisfied with its appearance, select 
Edit:Copy page. 

 
• Open your Word document and click at the location where you want the graph to be 

located. 
 

• Select Edit:Paste Special. 
 
• Select Origin Graph Object from the As list box. 
 
• Select the Paste radio button. 

 
• Click OK. 
 
Linking your graph into Word  
 
• You must first create your graph in Origin and then save it as part of an Origin project 

(*.OPJ). 
 
• Open the saved Origin project (if it is not already opened) that includes the desired graph 

window. 
 
• Make the desired graph window active, select Edit:Copy Page. 
 
• Open your Word document and and click at the location where you want to insert the 

graph. 



Lesson 7: Other Useful Details  

93 

 
• Select Edit:Paste Special. 
 
• Select Origin Graph Object from the As: list box 
 
• Select the Paste Link radio button. 
 
• Click OK. 
 
 
After your Origin graph is linked to Word you may return to the original Origin graph and 
make changes to the graph.  These changes can be reflected in the Word document by: 
 
• Select Edit:Update Client from the Origin menu (to make immediate changes to the 

Word document graph). 
 

(Shortcut: You may quickly start Origin and load the linked graph by simply double-clicking 
on the graph while in Word. Origin will be started with the original document loaded, the 
changes can be made and by selecting Edit:Update Client, the changes will be transferred to 
the Word document.) 
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Appendix:  Equations Used to Deconvolute DSC Data 

I. Independent Transitions 

 
It will be assumed here that a protein (or other macromolecule) is composed of a number 
of structural domains A, B, C, ..., each of which is involved independently in a transition 
between the folded and unfolded forms (A = A', B = B', ...).  Equilibrium constants will 
be expressed as fractions (KA = fA'/fA, KB = fB'/fB, ...) with the usual designation for the 
actual (i.e., calorimetric) molar enthalpy changes (∆HA, ∆HB, ...). 
The total molar enthalpy of the system H will be 
 
  H H f H f HN A B B= + + +' ' . . .∆ ∆    (1) 
 
 
 
The first term for the totally native form where all domains are in their folded state, HN, 
must be included since all ∆H values are measured relative to the folded form.  The total 
molar heat capacity of the system Cp is the temperature derivative of the enthalpy in eq 1, 
so 
 

  C C f C H
f
Tp pN A pA A
A= + + 













+'

' . . .∆ ∆
δ
δ

  (2) 

 
where CpN   is the molar heat capacity of the totally folded state, ∆CpA is the change in 
heat capacity for unfolding the A domain, and where the term in brackets will be 
repeated for each domain involved in unfolding.  Remembering that fA  = 1  - fA' , then 
the fractional concentration of the primed species can be readily expressed in terms of the 
corresponding equilibrium constant 
 

     f
K

KA
A

A
' = +1

      (3)  

 
which can then be differentiated to give 
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The derivative on the right of eq 4 is known from elementary thermodynamics 
 

   
δ
δ
ln K

T
H

RT
A A




=

∗∆
2     (5) 

 
where ∆HA

*  is the so-called van't Hoff heat change for the reaction which corresponds to 
the heat change for the cooperative unit which actually participates in the reaction.  
Substituting from eq's 3-5 into eq 2 then gives 
 



DSC Data Analysis Tutorial Guide 

96 

  
( )

C C
K C

K
K H H

K RT
p pN

A pA

A

A A A

A

= +
+

+
+












+

∗∆ ∆ ∆
1 1 2 2

. . .   (6) 

 
Eq 6 is perfectly general at this point and can be applied to either two-state or non-two-
state transitions so long as all parameters are evaluated at the same temperature T. 
 
 
Model for Independent Two-State Transitions including ∆Cp Effects.  
If we assume each transition is two-state, then all of the above van't Hoff ∆H* values 
become equal to the calorimetric  ∆H values.  If we further assume that CpN  can be 
expressed as a linear function of temperature (CpN = B0 + B1 T), then eq 6 becomes 
 

( ) ( )
( )

( ) ( )
( )( )

C T B B T
K T C

K T
K T H T

K T RT
p

A pA

A

A A

A

= + +
+

+
+














+0 1

2

2 21 1

∆ ∆
. . .   (7) 

 
where the temperature-dependent parameters Cp(T), KA(T), and ∆HA(T) have been 
indicated.  We can express ∆HA(T) in terms of its temperature-independent value at the 
midpoint TmA and the heat capacity change for the transition ∆CpA, i.e., 
 

( ) ( )∆ ∆ ∆H T H C T TA mA pA mA= + −    (8) 

 
 
 
and then integrate eq 5 from TmA where KA(T) is unity to an unspecified temperature T 
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Now, eq 7 (using substitutions from eq's 8 and 9 for each transition A, B, ...) may be used 
to calculate the value of the system heat capacity Cp(T)  at any temperature T once values 
of the temperature-independent fitting parameters B0, B1, TmA, ∆HmA, ∆CpA, TmB, 
∆HmB, ∆CpB, ...  are given.  To begin curve-fitting with Origin, the operator indicates the 
number of transitions needed to fit the experimental DSC heat capacity curve,  Cp(T)exp, 
and then initializes all of the Tm values so that Origin can provide guesses for each of the 
other fitting parameters.  Knowing these, it then calculates Cp(T) from eq's 7-9 and 
compares these values with Cp(T)exp.  Using Marquardt methods based on non-linear-
least-squares, the guesses for each parameter are then improved, the calculations carried 
out again, and this iterative process continued until there is no further improvement in the 
fit of  the calculated Cp(T) to the experimental Cp(T)exp as indicated by a minimum value 
of chi2. 
 
 
Model for Independent Two-State Transitions excluding DCp Effects.   
When all heat capacity changes ∆CpA, ∆CpB, ... are assumed to be zero, certain 
simplifications can be made in eq's 7-9.  Before curve-fitting begins, the operator 
subtracts a baseline from the data which effectively sets CpN  equal to zero at all 
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temperatures so that B0 and B1 are no longer used as fitting parameters.  Incorporating 
this, setting all heat capacity changes to zero, and recognizing that all ∆HA(T) for each 
transition may be replaced by the temperature-independent heat ∆HmA (i.e., heat changes 
must be temperature-independent if there is no change in heat capacity), then eq's 7-9 
simplify to 
 

   ( ) ( ) ( )
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where again the right-hand term in eq 10 must be repeated for each transition and where 
eq 11 must be evaluated for each transition.  In this case the fitting parameters are TmA, 
∆HmA, TmB, ∆HmB, ..., but otherwise the curve-fitting procedure is the same as described 
above. 
 
 
Model for Independent Non-two-state Transitions. 
Because of the extra fitting parameters required for the non-two-state vs two-state model, 
this model is only applied to transitions with no ∆Cp.  Before curve-fitting with this 
model, a progress baseline must be subtracted from the experimental data to remove the 
∆Cp  effects if they are present (this also sets CpN to zero at all temperatures).  To treat 
non-two-state transitions, the appropriate place to begin is eq 6 which still includes both 
calorimetric and van't Hoff heat changes.  Indicating the temperature-dependent 
parameters, this can be rewritten as 
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In this case, the equilibrium constants will be calculated as in eq 11 with the important 
exception that the van't Hoff heat, rather than the calorimetric, must be used since now 
the two will be different, i.e., 
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Eq's 12-13 are then used for curve-fitting in the usual way and the parameter set will be 
TmA, ∆HmA, ∆HmA

*,TmB, ∆HmB, ∆HmB
*  ... 

II.  Sequential Transitions 

Sequential transitions may occur in proteins (or other macromolecules) when the stability 
of each domain A, B, C, ... is dependent on whether other domains are folded or 
unfolded. The sequential model imposes a precise order in which domains must unfold 
for every molecule in solution, i.e., 
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where each step in the reaction scheme involves the unfolding of one of the domains in 
the appropriate sequence (i.e., step 1 is always the A domain, step 2 always the B 
domain, etc.).  The total molar heat content of the system (relative to a value of zero 
being assigned to the P0  state) will be 
 

( ) ( )H f f H f H H f H H H= ⋅ + + + + + + +0 1 1 2 1 2 3 1 2 30 ∆ ∆ ∆ ∆ ∆ ∆ . . .  (15) 
 
where the f's indicate the fractional concentration of each state and the ∆H's are the molar 
enthalpy changes for each step.  Using the K values, all of the f values can be related to  
f0,, so that 
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where 
 
  Q K K K K K K= + + + +1 1 1 2 1 2 3 . . . . . .    (17) 
 
Eq's 16 may be substituted into eq 15, which may then be differentiated with respect to 
temperature to obtain the system heat capacity.  Since ∆H values are treated as 
temperature-independent in Origin's sequential model, most of the derivatives involve 
using the relation 
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The final expression for the heat capacity of the system then becomes 
 

( ) ( ) ( ) ( ) ( ) ( ) ( ) ( )( )( )C T K T
H

RT Q
K T K T

H H
RT Q

K T H K T K T H Hp = +
+

+










 − + + +1

1
2

2 1 2
1 2

2

2 1 1 1 2 1 2
∆ ∆ ∆

∆ ∆ ∆. . . . . .

 ( ) ( ) ( ) ( )
K T

H
RT Q

K T K T
H H
RT Q1

1
2 2 1 2

1 2
2 2

∆ ∆ ∆
+

+
+









. . .     (19) 

 
where the temperature-dependent quantities have been indicated in the usual way.  The 
equilibrium constants can be evaluated in terms of the temperature-independent ∆H 
parameters from 
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Using eq's 19-20 and fitting parameters K1, ∆H1, K2, ∆H2, ..., the fitting procedure is 
carried out as described above for the models involving independent transitions. 

III. Single Two-State Transition with Subunit Dissociation 

It sometimes happens with biological macromolecules having subunits that subunit 
dissociation occurs simultaneously with thermal unfolding, i.e., 
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where n is the number of dissociable subunits and where the brackets signify molar 
concentrations of species.  If f is the fraction of macromolecule in the A state and 1-f the 
fraction in the An state, then 
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where Ct is the total bulk molar concentration (expressed as n-mer equivalents).  The 
equilibrium constant, using eq's 21-22, then becomes 
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Using eq 23 and the expressions 
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and integrating from TmA (where f=0.5) to T then gives 
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Once K(T) is known then f(T) may be solved from eq 23 using numerical methods and 
the excess heat capacity calculated from the equation 



DSC Data Analysis Tutorial Guide 

100 

 

( ) ( ) ( ) ( )

( )

C T B B T f T C
H T
RT

f T

n n
f T

p p
A= + + +

−

− +



















0 1 2

1

1
∆

∆
  (26) 

 
The above equations are general for any value of n so long as the bulk concentration Ct is 
expressed as n-mer equivalents.  For systems which associate when unfolding occurs i.e.,  
 

   A
j

Aj=
1

     (27) 

 
the same equations are valid, providing the bulk concentration Ct is expressed as 

monomer equivalents and that n in the above equations is equated to 
1
j

. 

IV.  Absolute Heat Capacity of Proteins 

The equation used to calculate Absolute Heat Capacity of Proteins is as follows: 

 
Where ∆Cp (cal/deg) is the sample-buffer baseline minus the buffer-buffer baseline, go is 
the concentration of protein (gm/ml) in the solution, ρ(t) is the relative density of water 
(stored in Origin as a polynomial in t), Vo is the nominal volume (ml) of the sample cell, 
t is the temperature in °C, CP

P  (t) is the absolute heat capacity (cal/deg/gm) of the protein 
in solution, ν is the partial specific volume of the protein (ml/gm), α is the coefficient of 
thermal expansion of the protein, and CW

P   (t) is the unit-volume heat capacity of water 
(cal/deg/ml). CW

P   (t)  is calculated from literature data on the specific heat and density of 
water as a function of temperature, by fitting to a polynomial in temperature.  The 
thermal coefficient of cubical expansion of tantalum is .00002. 
 
The above equation is solved for CP

P  (t) from the experimental data file ∆Cp, using the 
stored polynomial expressions for CW

P   (t) and ρ(t) as well as the operator-input 
parameters go, ν,  α, and Vo. 
 
This procedure assumes the relative density and the unit-volume heat capacity CW

P    of the 
buffer solution can be replaced by the corresponding properties of pure water.  This 
should be a very good approximation at electrolyte concentrations commonly used in 
buffer solutions, but would be less accurate at very high electrolyte concentrations (>1M) 
or in the presence of high concentrations of organic additives.  Also, the value obtained 
for CP

P   depends strongly on the partial specific volume of protein, so it is desirable to 
have an experimental value of  ν for the protein in question at a single temperature, at the 
least.  The coefficient of thermal expansion is typically small (~ 10-3 -  10-4) and exerts 
only a small effect on the CP

P   value over a moderate temperature range. 
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V. Calculating Protein-Ligand Binding Constant from DSC Data 

 
Ligands frequently bind much stronger to the native, folded form of a protein than they do to the 
thermally unfolded form.  The treatment below assumes no binding to the unfolded form. This 
being the case, the thermal midpoint of the unfolding transition will necessarily occur at a higher 
temperature, TM, when the ligand is present in solution than when the ligand is absent, To.  For 
reversible transitions, the equation relating the shift in midpoint to the binding constant KB has 
been derived earlier (Brandts, J. F. & Lin, L. –N. (1990) Biochemistry 29, 6927-6940.) and is 
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where KB(TM) is the binding constant at TM, ∆Ho and ∆CP are the enthalpy and heat capacity 
change for the transition at To, [ ]

MTL  is the concentration of unbound ligand at TM, and n is the 

number of binding sites on the protein. Transition temperatures are expressed in oK.  The above 
equation is most useful when TM and To are well-separated in temperature.  A very large KB 
insures there will be large separation in midpoint no matter what the ligand concentration, while 
measuring TM in the presence of high ligand concentration will produce large separation even for 
weak or moderate binding. In the former case involving large binding constants, addition of less-
than-saturating ligand concentration results in separate transition peaks for the liganded and 
unliganded proteins so that To and TM may be obtained in the same experiment.   
 
 The value of free ligand concentration at the midpoint TM can be calculated from the equations 
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where Ptot and Ltot are the total concentrations of protein and ligand, respectively, in the solution. 
While ligand release will occur at TM and contribute to the total experimental heat of unfolding, it 
is generally not possible to obtain a reliable estimate of this since the heat from ligand release 
usually constitutes such a small fraction of the total heat of unfolding. 
 
However, If one knows the heat of binding independently (e.g., from ITC experiments) it then 
becomes possible to extrapolate the KB value, obtained from equations (29) and (30) at TM,  to 
another temperature TF using the equation (Brandts, J. F. & Lin, L. –N. (1990) Biochemistry 29, 
6927-6940) 
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where ∆HB and ∆CP are the heat and heat capacity of ligand binding, respectively, at TF. 
 
 

 (30) 
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VI. Calculating Protein-Protein Binding Constant from DSC Data 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
When estimating the binding constant for protein-protein interactions,  
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the approach is a little different than for ligand-protein interactions, since both of the proteins P and 
P’ will undergo their own thermal unfolding transition.  This is illustrated in the above Figure where 
To, ∆Ho, and ∆Cp refer to transition parameters for P alone and To’ , ∆Ho’, and ∆Cp

’ are the 
corresponding parameters for P’ alone.   
 When P and P’ are mixed together in the same solution, then a separate transition will be observed 
for the complex PP’ with transition midpoint TM.  A second transition might also be seen at either To 
or To’ depending on whether P or P’ is in excess (i.e. in autosampler routine the program will have to 
determine the largest peak).  If TM occurs at a temperature between To and To’ then the regular model 
for ligand-protein may be used to calculate the binding constant. 
 If TM occurs at a temperature higher than both To and To’ then a different model must be used 
which takes into account the temperature shift in both transitions.  In this latter case, the binding 
constant at TM, KB(TM), can be obtained from the following equation 
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VII. Using DSC data to calculate ∆G at temperature T by extrapolating from the 
midpoint TM 

 
From analysis of a DSC scan on a protein, three experimental parameters for the unfolding transition are 
obtained.  These include  
 

midpoint = TM 
     Enthalpy change at TM = ∆H(TM) 
     Heat capacity change at TM = ∆Cp 
 
Using these three experimental parameters, the Gibbs free energy change ∆G may then be obtained at any temperature 
T as indicated below.  The derivation assumes a reversible two-state transition and also assumes ∆Cp is independent of 
temperature. 
 
Derivation: 
 
Starting from well-known thermodynamic relation 
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and transforming to an integral equation gives 
 

[ ]∫∫ ∫ 





∆+∆=






∆=






 ∆ T

T
MpM

T

T

T

T MM M
T
1d )T-T(C)H(T

T
1d H

T
Gd  

 
Integrating the above equation from TM (where ∆G=0) to another temperature T then gives 
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Once the temperature T is assigned, all other parameters in the above equation are known except ∆G which can then 
be calculated. 
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Index 

A 

Absolute heat capacity 
equations, 100 
fitting example, 54–57 

Active data set, 13 
Autosampler, 59–73 

binding constants, 68–73 
buttons, 60 
Conc. 1 & Conc. 2, 64 
find delta Tm, 65 
find one Tm, 64 
find two Tm, 66 
normalize concentration, 63 
response time, 63 
subtract baseline, 62, 67 
Y offset, 65 

B 

Baseline, 17–18, 37–44 
adjust linear segments, 39–40 
adjust the default baseline, 43 
baseline menu commands, 38 
baseline session, 38–42 
cubic connect baseline, 41–42 
default name, 44 
linear connect baseline, 41 
move baseline by cursor, 42 
progress baseline, 40–41 
restoring, 22–23 
select baseline type, 40 
step baseline, 42 
subtract from DSC data, 44 
viewing worksheet data for, 44 

Binding constants, 68–82, 68–82 
from autosampler data, 68–73 
from standard DSC data, 77–84 

Buttons, 10 
autosampler, 60 

C 

Calibration, 24 
Chi-Sqr button, 21 
Chi-Sqr minimization, 88 
Concentration, 15–17 
Curve fitting, 19–23 

choosing a model, 45–46 
Dissociation w/dCp, 51–53 
fitting iterations, 50 
fitting models described, 19, 45–46 
fitting session, 20–22 

 
 
formatting parameters text, 23 
Line types, 91–92 
sequential model equations, 97–99 
Two-state model, 20–22 
Two-state w/dCp model, 22–23 

D 

Data files 
automatic scan rate normalization, 10 
keeping time data, 10 
offsetting data, 10 
opening, 11–13 

Data Selector tool, 25–28 
hiding data markers, 34 
setting integration range, 29–31, 70, 79 

Data set 
create baseline for, 17–18 
create new data set, 34 
deleting selected segment, 27 
fitting a curve to, 19–23 
importing, 7 
integrating, 29–35 
normalizing, 15–17 
opening worksheet for, 14–15, 44 
plotting, 34–35 
set as active, 13 
subtracting reference, 13–14 

Deconvolution. See Curve fitting 
Delta G, 84–87 
Dissociation w/dCp, 51–53 

E 

EndInteg macro, 31 

F 

Fitting. See Curve fitting 
Fitting parameters 

defined, 45–46 
for four models, 19 
format parameters text, 23 

Fitting Session, 20–22 

H 

H parameter (heat change), 45–46 
Hv parameter (van't Hoff heat change), 45–46 

I 

Import Multiple ASCII dialog box, 11–12 
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Importing data, 7 
Installing Origin, 3 
Integration, 29–35 

copy integration area data, 34 
displaying integration results, 32 
EndInteg macro, 31 
formatting integration results, 32–33 
integrating selected range, 31 
integration results, 29, 31 
plot integration area data, 34–35 
setting integration range, 29–31 

Isothermal scan, 7 

L 

LabTalk script language, 34 
Layer Control dialog box, 34–35 
Line Types for fit curves, 91–92 

M 

Math dialog box, 23 
Menu levels, 5–6 

N 

Nonlinear least squares fitter, 20–22 

O 

Offsetting multiple DSC files, 10 
Opening and Analyzing Previous Versions of 

Origin (*.ORG) Documents, 8 
Opening DSC data files, 11–12 
Opening Worksheet window, 14–15 

P 

Page View mode, 7, 23 
Pick Peaks tool, 80 
Plot window 

maximizing, 38 
Print View mode, 7, 23 

R 

Reference data 
subtracting from sample data, 13–14 

Registering with MicroCal Software, 5 
Response time 

autosampler data, 63 
FeedBack modes, 89 
relaxation time constant, 89 

Response Time, 68–91 
Response time button, 89 

S 

Scan rate normalization, 10 
and instrument calibration, 24 

Scripting, 34 
Sequential model 

equations, 97–99 
Set Default Directory, 12 
Simplex minimization 

nonlinear least squares fitter, 21 
Starting Origin, 5, 9 
Subtracting reference data, 13–14 
System requirements for Origin, 3 

T 

Text formatting, 23, 32–33 
Tolerance, 50 
Two state model, 20–22 
Two state with dCp, 22–23 

V 

View mode 
and screen refresh rates, 6 
available types, 6 

W 

Window View mode, 7 
Worksheet 

viewing data, 14–15 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 


